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‘‘Wrapping vehicles 
requires hands-on 
training, research, 

and monetary invest-
ments in equipment 

and materials.’’
CHARIT Y JACKSON 
from Getting Started in Wraps
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W inter is a time for staying indoors with a delicious beverage, and occasion-
ally that means running to the local beverage store for supplies. As it turns 
out, I recently received a flyer from my favorite local beverage store in the 

mail that had what at first glance looked like an incredible coupon. “Save 20% on 
Any Purchase Over $40!” 

Well, we tend to clear $40 pretty easily on our trips, so this was a no-brainer of 
a deal. My favorite beverage store, which is my favorite because of their excellent 
product selection and solid customer service, was hooking me up with a sweet deal. 
Obviously because they like me so much and appreciate my regular business, and 
certainly not just because I lived in a specific geographic location included in their 
direct mail marketing plan. 

But then I saw the fine print. Is there ever good news in fine print? A minimum 
purchase of six bottles of wine was required as part of the terms and conditions of 
the deal. Immediately that great deal wasn’t so great because now to get the deal, we 
would have to shop on the store’s terms and not my own. I could get the deal and 
limit my options, or just toss the coupon. 

There’s a reason that direct mail, especially locally, is still one of the best buys when 
it comes to advertising — because I still went through the mental gymnastics to see 
if there was a way to take advantage of this deal. Like I said, it’s my favorite store.

But did I need six bottles of wine? Well, as it turns out, I’m part of a wine club. And 
for those of you who are also in a wine club, you know that they call it a club because 
they beat you over the head with wine shipments and you really need to put in time 
and effort to run low on supply. And suffice it to say, I was good on wine for a bit. So, 
purchasing six bottles of wine, no matter how good the deal, was out of the question. 

So that left me with the option to just recycle the coupon, with my last thought 
about the store being negative because of their terms and conditions. Or as my wife 
so eloquently said, “This coupon is bull$#&@.”

But what if this hadn’t been my favorite store? What if this was my introduction to 
this store? Is the best way to build business a non-inclusive deal? Is the first impression 
you want to make a few lines of fine print that make your customer feel like you’re 
trying to pull a fast one? In a world where people are constantly asking, “What’s the 
catch?” how embarrassing is it to actually have a catch?

Customers like to take advantage of deals. They don’t like to feel taken advantage of 
while trying to find deals. So, keep that in mind when you do anything that involves 
fine print. If you think you’re benefiting yourself by including some kind of “gotcha” 
in your great deals, you’re doing it wrong. GP

TERMS AND 
CONDITIONS

GP_FEB22.indd   8 1/14/22   10:02 AM

https://graphics-pro.com/
https://graphics-pro-expo.com/
https://www.nbm.com/


SETTING NEW STANDARDS

SETTING NEW 
STANDARDS

SETTING NEW
STANDARDS

SETTING NEW
STANDARDS

SETTING NEW
STANDARDS

SETTING NEW STANDARDS

SETTING NEW 
STANDARDS

SETTING NEW
STANDARDS

SETTING NEW STANDARDS

SETTING NEW 
STANDARDS

SETTING NEW
STANDARDS

Upgrade for free now on
ruby.troteclaser.com
for your Speedy Laser

Ruby®
Laser Software 
Redefined.

Makes working with your laser simpler and faster. Digital to the core.

Manage, design, prepare all your laser jobs in one seamless workflow from idea to product. Import graphics or photos, create text 
or graphics, prepare the job remote or locally and run the laser from the network - a user interface that delights. 
Ruby® - start your digital journey now.  

ruby.troteclaser.com

GP_TROT_2112A.indd   1 1/17/22   1:54 PM

https://www.troteclaser.com


GRAPHICS-PRO.COM 2 0 2 2 F E B R U A R Y  G R A P H I C S  P R O 1 11 0 G R A P H I C S  P R O  F E B R U A R Y  2 0 2 2 GRAPHICS-PRO.COM

IN THE TRENCHES  RICK WILL IAMS

NEVER TOO YOUNG

Some years ago, after attending a 
trade show in Columbus, I drove 
my rental car out into the country-

side northeast of the Ohio capital, where 
my son and I had made friends with a 
sign maker named Maryellen, her hus-
band Gene, and their three daughters. 
Maryellen had attended an all-day screen-
printing workshop I taught there a few 
years before, and this wasn’t my first visit 
to their beautiful rural homestead outside 
of Danville, Ohio.

When I arrived, Hannah, their young-
est daughter, volunteered to take me on 
a four-wheeler ride on that beautiful late 
spring day, and I gladly accepted. Our first 
stop was a nearby hilltop that overlooked 

that beautiful landscape. Her second stop 
was a working farm that their neighbors, 
a large Amish family owned and operated.

At that moment, most of the family 
members had traveled by wagon to visit 
nearby friends, so the home place was be-
ing overseen by their two elementary age 
sons, Eli and Levi.

These handsome little boys, dressed in 
overalls and small straw hats, were kind 
enough to give their neighbor and her 
much older friend a tour of the place, first 
the well-made home, then the fields, and 
finally the 100-year-old barn. In one of 
the rooms of the barn, the boys explained 
that this was where they did a part of their 
daily chores, as we were standing in the 

cow milking area that had just been used 
a short while before we arrived. 

One of them described how they got up 
early every morning and started milking 
around 5:30 a.m., then repeated the task 
at 5:30 each evening. It was about 6:30 in 
the evening right then, so they must have 
been pretty fast at it. 

“Boys,” I said, “if you have to be up that 
early every single day, at what time do you 
normally go to bed?”

“Oh, just about any time now,” they 
both responded.

Their “anytime now” answer made me 
smile, thinking about these two little fel-
lows who already knew how to work and 
keep a tight schedule. They wouldn’t be 

GP_FEB22-ADS.indd   10 1/17/22   11:27 AM
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IN THE TRENCHES  RICK WILL IAMS

going to bed with the chickens, they’d be 
asleep before the chickens.

Not for one moment did I think that Eli 
and Levi were somehow being mistreated. 
On the contrary, they were learning how 
to work and how to assume real respon-
sibility at an early age. It’s my guess that 
most American kids, living normal urban 
lifestyles, are taught how to work, and are 
given productive work to do, way too late 
in their lives. And there are negative con-
sequences that go with that very common 
reality.

My parents were only a little ahead of 
that process, but for me it didn’t mat-
ter as my best friend, Bob, now a pretty 
important fellow around the offices of 
NBM Inc., the company that publishes 
this magazine, practically dragged me into 
the workforce with him at the age of 12 or 
13. But by then, he was a seasoned veteran 
compared to me. 

Coming from a large family of very mod-
est means, he had determined if he was to 
have much more than food, clothes, and a 
roof over his head, he’d have to buy what 
he wanted himself. Little Bobbie started 
to work at the age of 10 and has never 
stopped.  

We competed for the top spot on a sub-
scription sales crew of boys who sold the 
local morning journal for three months 
each summer. Our newspaper was dis-
tributed in every town within a 50-mile 
radius, and we walked the streets of each 
one, delivered there by our boss in one 
old car containing himself and four or five 
sweaty little boys. I rarely beat my best 
bud at selling the most subscriptions any 
given day or week, but we both had more 
spending money all summer than any two 
kids in our neighborhood, or in our school 
for that matter.

But much more valuable than that, as 

just adolescents, we learned to work, to 
earn our own money, and to speak con-
vincingly to just about anyone. Moreover, 
were introduced to a new world at an early 
age. It was not the world of farm animals 
like little Eli and Levi. What we received 
was an early entry into a whole new world, 
a very important world, the world of adults. 

When it came time for us to make our 
own way in that realm, in the real adult 
world we all have to live in, and the world 
of business, we were ready. Not every 
young person is, especially these days. Not 

even close. I am thankful for the influence 
of a little sandy haired boy, who had a great 
future ahead of him, and helped me get 
ready for my future as well.

RICK WILLIAMS owns Rick’s Sign Company, a com-

mercial sign shop in Longview, Texas. He has been in 

the sign industry since 1973 and has been a contributing 

editor to Sign Business and Sign & Digital Graphics since 

1986. Contact Rick via email at ricksignco@aol.com.
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S I G N A G E  &  P R I N T I N G

I
t is said that beauty lies within. The 
phrase points to a deeper, more pro-
found value than what can be found 
on the outside. In the graphics world, 

it’s hard to imagine judging beauty by 
anything other than external appear-
ances. However, looking within a wrap 
shop, one will find there is more involved 
than just ink printed to a piece of vinyl 
film. This is especially true when notic-
ing a shop’s interior walls and how it rep-
resents its business.

“What better way to fine tune your skills 
and show off your skills than to wrap your 
own shop,” says Brian Piper, partner at 
Sykes Printing. “We test everything in-
house prior to offering it to our clients. 
And find it makes for a great conversation 
with our neighbors.”

Outdoor graphics will always have a 
place in the market since they are typically 
installed in prevalent, high-trafficked areas. 
But indoor graphics have steadily become 
more popular in places like offices, on 

windows, floors and other surfaces. These 
are the spots where shops can build brand 
identity or create a more inviting environ-
ment for customers and visitors. 

“Indoor projects are typically in predict-
able environments,” adds Nicholas Lowry, 
president of Brand Ink.

But “predictable” doesn’t always trans-
late to “easy.” There are several steps and 
guidelines to follow to complete a success-
ful interior wrap. 

THE
INSIDE
How interior graphics can enhance 
the business of wraps shops B Y  R YA N  F U G L E RJOB
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SELECTION & SURVEYING
With advancements in vinyl film produc-
tion comes a wide range of selection. Film 
is available in different thicknesses, flex-
ibilities, and finishes. To install interior 
wraps, it is important to assess the condi-
tions of the surfaces and determine where 
graphics can and cannot be placed. Many 
film manufacturers offer products that 
are fit for both indoor and outdoor use, 
however, if the surface is rough – like an 
exposed brick wall – shops should choose 

a film that is made specifically for it. Other 
considerations might include how long to 
expect the graphics to last – even if UV ex-
posure and weather conditions don’t play 
a factor indoors. 

“Indoor graphics seem easier without the 
weather element, but you have to think 
about the human element,” says Brittany 
Eppley, corporate marketing communica-
tions manager for Mactac. “Will the instal-
lation interrupt the customer’s workday? 
What kind of cleaning will be needed for 
the area before the graphic is installed? The 
print shop will also need to think about 
how the indoor lighting might affect the 
graphic. Will a matte or gloss laminate cre-
ate glare in the space?”

For those shops attempting to boost their 
indoor graphics work, there are often quite 
a few matters to consider that may not 
initially come to mind. For example, there 
are many elements to plan out before the 
graphics even touch the surface.

“Taking away the concern about expo-
sure to weather allows for more freedom 
when using media to enhance the design 
of a space,” according to Jay Kroll, prod-
uct manager, cut and craft films, wall and 
transit media, General Formulations. “It 
is important to consider the surface where 
the graphic is being installed and ensure 
both primer and paint are sound, that the 
wall is clean, and that you’ve tested the ma-
terial on the surface for adequate bond.”

?inyl film manu\acturers o\\er products 

that allow interior graphics to be installed 

on a variety o\ di\\erent sur\aces including 

brick and �ooring. ±Image courtesy �'²
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Preparing for the work is key, and it is a 
step that should never be skipped.

“When considering doing an interior 
wrap application, an installer needs to do 
a lot of pre-work before recommending a 
film to be used,” says Joey Heiob, techni-
cal service representative, Avery Dennison 
Graphics Solutions. “It is the responsibil-
ity of the installer to test and qualify the 
film on any interior surface. Today’s paint 
systems (low VOC) do not typically pro-
mote good adhesion for pressure-sensitive 
adhesive films so they must see if the film 

will properly anchor prior to doing any 
full-blown application.”

Take it from a wrap shop owner, the 
work upfront pays off in the end. 

“When visiting the site in advance of 
the work, we use a 3M wall test kit,” says 
Lowry. “It doesn’t matter how good the 
graphics look on install day if they start 
falling off the wall in a couple of weeks or 
can’t be cleaned with commercial cleaning 
products repeatedly.” 

When cleaning graphics, laminates can 
help keep the surface protected and du-

rable. Lamination is usually recommended 
for outdoor graphics applications; howev-
er, indoor graphics do not always follow 
the same protocol. 

“Floor graphics, high-touch surface 
graphics, and other graphics which are 
expected to experience frequent surface 
contact should always be laminated, as 
the printed ink layer will not withstand 
these mechanical abrasions,” says Andrew 
Smith, application engineer, 3M Commer-
cial Solutions Laboratory. “Wall graphics 
and other low-touch surfaces do not always 
need a laminate, particularly in more tem-
porary applications where the durability 
requirement is less than six months.”

Print shops are becoming more creative 

about where to install interior graphics 

such as staircases, desks 

and more. (Image 

courtesy 

3M)

Interior wraps can set the tone where meetings take place with potential customers. (Image courtesy Mactac)
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Kroll has a similar suggestion, stat-
ing, “The use of laminates depends 
on the location and intended use of 
the graphic. If you’re wrapping the 
hallway of a school or children’s wing 
of a church, a protective laminate will 
help extend the life of your wrap and 
make cleaning that much easier. With 
textured wall films, liquid laminate 
coatings provide an excellent option 
for protection, and several even have 
functional additives available to give 
anti-microbial or anti-graffiti proper-
ties.” However, for most installations, 
laminates are a nice element to have, 
but they aren’t always necessary.
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�y decorating o\fices with wraps, shops can tout their design and install skills to all visitors o\ their buildings. ±Image 

courtesy �ñ' �raphic @raps²

6hops can test out di\\erent kinds o\ graphics to fit the o\fice environment, changing the theme as o\ten as necessary. 

±Image courtesy �very �ennison²

J oey �eiob at �very �en-

nison �raphics 6olutions 

lists some wuestions that 

installers can use as a checklist 

regarding their pre·work prepara-

tion as well as choosing films and 

laminates. The typical in\ormation 

you need to gather be\ore recom-

mending a film and beginning 

installation is¤

a² @hat is the substrate ±sur\ace² 

where the film will be ap-

plied© Is it smooth¯�at or is it 

textured©

b² @hat kind o\ paint is on the 

substrate ±sur\ace² being ap-

plied to and when was the 

sur\ace last painted©

c² @hat printing capability does 

the converter have i\ you are 

going to digitally print the 

graphics©

�nd whether interior wraps are 

laminated can depend on a \ew 

\actors¤

�² @hat film is being used©

�² �ow long does the client 

expect the graphics to last or 

want them to last©

�² @ill the graphics be located 

where they can be touched 

or \elt by human 

hands©

INSTALLATION CONSIDERATIONS
Once the surface space is chosen and the 
right film has been selected, installation 
steps can commence. A benefit of indoor 
graphics is not having to contend with 
inconsistent lighting as sunlight doesn’t 
typically present a problem. But that also 
means that any flaws in the graphics or 
installation will be ever visible without 
variations in the lighting.
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“For interior colors if there are shadows 
and low light conditions, we use brighter 
colors and colors that enhance the room,” 
says Andrew Napolean, owner of A&M 
Graphic Wraps. “Colors are key in all as-
pects of advertising from being loud to 
being soft. They can set the mood from 
the very beginning.”

Perfecting the seams and edges is another 
way to make sure no flaws are easily visible. 
Installers should take measurements and 
plan where graphic panels will be affixed. 

“When installers do large interior wraps 
there are typically going to be multiple 
panels involved which means they will 
have to seam the panels,” says Heiob. 
“The recommended overlap seam width 
is one inch. When working with textured 
films, the use of either adhesive promoter 
or banner hem tape is required to provide 
extra hold for those types of film seams.”

Kroll warns to also watch for “any 
shrinking of the media or relaxing of ten-
sion on the graphic. This (seam) overlap 
will also make it easier for lining up panels 
or parts of a larger graphic.”

When installing interior graphics and 
working inside of buildings and potentially 
shared space, there could be regulations 
to follow.  

“As an example, indoor graphics may 
need to be GreenGuard certified, depend-
ing on the relevant local building codes,” 
tells Smith. “The 3M Envision line of 
graphic films are certified as GreenGuard 
Gold, and construction teams can receive 
LEED credits for their building by using 
these 3M Envision films in place of a more 
standard PVC film combination.”

For more non-traditional graphics, such 
as floor graphics, there are other rules to 
consider that help to eliminate safety con-
cerns.  

“Another certification that comes to 
mind is UL 410, which governs the use 
of different materials for floor surfaces,” 
adds Smith. “Because graphics placed on 
a walking surface may represent a trip or 
slipping hazard, 3M recommends installers 
use a UL 410-listed overlaminate.”

Overlaminates are recommended when “a space will have UV exposure, if the area will be cleaned regularly with 

cleaning sprays or if there is a worry about damage from human interaction,” says Brittany Eppley, Corporate Market-

ing Communications Manager, Mactac. (Image courtesy Mactac)

Using interior graphics correctly and creatively can turn a normally drab white wall into an artistic mural. (Image cour-

tesy A&M Graphic Wraps)
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OUTSIDE THE BOX
Floor graphics are just one example of 
several non-traditional indoor wraps. 
Through the years, shop owners have 
wrapped elevator doors, tables, and even 
refrigerators. When working indoors, 
there is a creativity factor that is often en-
hanced by the nature of the environment.

“Our creative studio has all the walls 
and floor vinyl-wrapped with fun colorful 
graphics,” says Katherine Arama, creative 
director, FASTSIGNS Boca Raton. “Our 
office is on a second floor so we also vinyl-
wrapped the stairs with Pantone colors on 
each step which makes an impression at 
the time our clients walk in.”

No matter what is being wrapped, it is 
important to convey a consistent overall 
message. If there isn’t a final plan in mind, 
then it’s just another wrap job that loses 
its allure. 

“It is common to see an accent wall in 
a foyer, or a vinyl decal behind the re-

ception desk,” says Kroll, “but the most 
memorable installs I have seen are those 
that follow a theme and takeover the 
whole space. Graphics that run from wall 
to door to floor.”

In many instances, a section of unused 
space can be transformed into a graphics-
laden work of art. Office eye sores can 
become stunning spectacles as brands and 
images come to life.  

“Something to also consider is how 
you can take a non-perfect environment 
and use it as an upsell opportunity,” says 
Lowry. “(Do you) have a client with dry-
wall walls that isn’t willing to get them 
to a nice class 5 surface in advance of 
the graphics install? That can be a great 
opportunity to introduce one of 3M’s 
8600M series overlaminates, which will 
give the surface a unique finish but also 
hide the imperfections of the wall.”

Of course, nobody ever wants to push 
forward a stale message. After a certain 

amount of time, a business will want to 
switch out its graphics so they can keep 
their campaign fresh. They may also seek 
out some other areas and structures to 
wrap.  

“Interior glass (e.g., office dividing 
windows), brick walls, and concrete 
pillars are a few examples of surfaces 
that aren’t always fully utilized in office 
spaces,” says Smith. “These are surfaces 
that the office management may not be 
aware can even be wrapped, but all three 
can provide an office space with a lot of 
unique flare.”

As far as when to change out graph-
ics, most shops agree that “regularly” is 
a good plan.

“Ideally every three months, no matter 
the kind of business,” says Arama. “You 
want to keep your store fresh and updated 
with new graphics that can inform, direct, 
enhance brand visibility or simply create 
a nice atmosphere.”

Interior graphics can carry a theme \rom �oor to ceiling unlike any type o\ typical media. ±Image courtesy �very �ennison²
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At A&M Graphic Wraps, Napolean prefers to shift 
with the seasons. 

“If it’s Christmas, we do a Christmas theme. If its Hal-
loween, we do the same,” he says. “It keeps us in season 
and constantly educates the customer to the different 
abilities we have without having to do a sales pitch.”

SHOP TIPS
At the end of the day, wrap shops should design their 
interiors to highlight their strengths while also using 
products that bring out the best in them. It’s something 
they can discuss with their clients when they are inside 
the building. 

“What percentage of customers are coming into your 
space, and at what point in the sales cycle?” asks Lowry. 
“Are they the kind of customers that are likely to be 
swayed by the environment you cre-
ate for your clients and team, or are 
they purely interested in the bottom-
line cost of things?”

How customers interpret the 
graphics inside a shop’s walls might 
hint toward how they would like a 
job done for them. One set of graph-
ics can be an instant conversation 
starter with a client.

“We always approach every single 
job differently as dimensions, walls, 
textures and paints are never the 
same,” explains Arama.

And when it comes down 
to it, nothing is out of 
bounds with indoor wraps. 
As Eppley states, “Now, you 
can basically wrap anything 
around you. A once ordinary 
wall can be brought to life by 
adding a large wall graphic to 
brighten the room and add 
that pop.”

So, when wrap businesses 
are considering their next 
projects, they might not need 
to look any further than their 
own shops. GP

RYAN N. FUGLER is a former editor of 

WRAPS magazine and has been cover-

ing the signage industry since 2006.

Left: Navigating 

around corners and 

obstacles on walls 

or overhead is al-

ways a consider-

ation when installing 

indoor graphics. (Im-

age courtesy Gen-

eral Formulations) 

Below: Sykes Print-

ing uses GF 226 

�T5 film \or lobby 

walls, taking mea-

surements to ensure 

proper fit and fin-

ish. (Image courtesy 

Sykes Printing)
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@rap shops can push the envelope o\ their talents by incorporating messages and brand identity into their interior graphics. ±Image 

courtesy Sykes Printing)
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Getting Started in Wraps
CONSIDERATIONS FOR A 
WORTHWHILE INVESTMENT
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W
hen we first started offering vehicle wraps, we had al-
ready been in business for about eight years, and wraps 
were a natural progression from the vehicle lettering we 
were already doing. We bought one of the first large-

format digital printers in our town and were very early adopters; this 
meant we also dealt with a lot of the early headaches as we worked 
through material and ink issues.

There was a lot of trial and error, wasted material, and product failure 
in those early years. Training resources were pretty limited back then, so we had 
to do most of the figuring out on our own. Fast forward about 19 years, and 
the industry has completely changed. The print quality of printers has vastly 

This full wrap was designed to work 

around obstacles and for the back-

ground design to look good from one 

surface of the vehicle to another. (All 

images courtesy Charity Jackson)

B Y  C H A R I T Y  J A C K S O N

improved, while the cost of 
machines has significantly 
dropped. There are more 
manufacturers to choose 

from, each with a line of 
products that meet various 

needs while incorporating im-
proved technology. It’s a great time 

to get started in the wrap industry, but 
there are some things you need to con-
sider before making the jump.

GP_FEB22-ADS.indd   20 1/17/22   11:36 AM



GRAPHICS-PRO.COM 2 0 2 2 F E B R U A R Y  G R A P H I C S  P R O 2 1

DON’T DABBLE
To offer high-quality workmanship and to 
maximize your profitability, you can’t dabble 
in this industry. It’s not like choosing to add 
in banners when you’re already doing signs. 
Wrapping vehicles requires hands-on training, 
research, and monetary investments in equip-
ment and materials.

There is a ton of information available on 
the market – videos, manufacturer bulletins, 
supplier training courses, and hands-on educa-
tion and certification programs. I highly recom-
mend taking the time to do some research. See 
what areas interest you most, check into train-
ing programs, and list what your shop would 
need to add to offer vehicle wraps, so you have 
a clear picture of what your costs will be.

Do you want to specialize in color-change 
wraps or commercial advertising wraps? Or 
both? Do you plan to print and install, or do 

Wrapping cars doesn’t always mean a full wrap. Partial wraps can meet both the customer’s advertising needs and their budget.

you want to specialize in installation only? Will you outsource your graphics 
while working directly with your customer or specialize in contract installation 
for other print shops? Do you want to be a certified installer for one or multiple 
manufacturers?

To break down the path we took – our shop specializes in commercial wraps and 
partial color-change wraps. We print in-house for most of our wraps while also 
offering installation for large print houses with nationwide contracts, and I’m an 
accredited 3M preferred installer.

IN-HOUSE OR OUTSOURCE
If you’re already doing full-color printing in-house, you have a printer, laminator, 
worktable, computer, RIP software, and design programs. You may need to add to 
your current equipment or software, but you’ve already made some initial invest-
ments.

If you’re just getting into the industry or are branching out on your own, you have 
a couple of options. You can choose to print in-house, which means you’ll need to 
invest in the equipment necessary to do so, or you can outsource the graphics while 
you do the installation.

If you decide to outsource your graphics, you’ll need to find a reliable source for 
your printed graphics. Make sure you have a solid understanding of the materials 

GP_FEB22-ADS.indd   21 1/17/22   11:37 AM



2 2 G R A P H I C S  P R O  F E B R U A R Y  2 0 2 2 GRAPHICS-PRO.COM GRAPHICS-PRO.COM 2 0 2 2 F E B R U A R Y  G R A P H I C S  P R O 2 3

you want to use, including the proper overlaminate, so that you know what to look 
for from your supplier.

If you do outsource, consider you’ll have less control over color management, 
and you won’t be able to do quick reprints for messed up or ill-fitting panels. Also, 
consider whether you’ll be designing the wraps and providing the artwork to the 
printer or if that will also be outsourced.

As previously mentioned, it’s important to research the path you want to take in 
this industry because if you plan to specialize in color-change wraps, then you won’t 
need to worry about outsourcing printed graphics. Rolls of color-change media can 
be purchased from a wholesaler and are ready to install. Vinyl samples are available 
for your customer to choose from, so you don’t have to worry about color discrep-
ancies either.

TOOLS AND EQUIPMENT
So, as you consider the path you’ll take in the wraps market, here’s a partial list of 
equipment and tools you may need to invest in. Some are necessary, and some are 
handy. This is not an exhaustive list, but as you choose what to add to your arsenal, 
make sure that the investment improves the quality of your workmanship, makes 
you more efficient, or does both. That’s how you know whether the tool or equip-
ment is worth the cost.

If you plan to print your graphics in-house, 
you’ll need to invest in a large-format printer 
that can print at least 48" to 60" wide pan-
els. You’ll also need a cold, pressure-sensitive 
laminator that accommodates laminates at the 
same widths as your print media.

Many large-format printers also have a cut-
ter built in, so you may not need to invest in 
a separate cutter initially. As your volume of 
work increases, you may consider a separate 
cutter that’s compatible with your printer so 
that you can be contour cutting graphics with-
out interrupting the workflow on the printer 
itself.

We’ve invested in a back-lit application table 
that we use in conjunction with our lamina-
tor for laminating and prepping graphics. We 
love our table for sign application especially, 
so it’s not necessary for just starting in the 
wraps industry but may be a worthy invest-

ment down the line. Initially, though, you will 
need a large work surface, preferably at least 
5' X 12', with a cutting surface for trimming 
laminated graphics.

You will also need a fast computer, RIP soft-
ware, and design software for creating and out-
putting your graphics. Racks for storing media 
rolls and drying your printed graphics will also 
need to be purchased.

For contour cut graphics, you’ll also need to 
apply application tape. You can purchase or 
build an application tape dispenser, or if you 
invest in an application table, there is a built-in 
bar that you can mount application tape rolls 
on for easy masking. You’ll also need a safety 
straight-edge and heavy-duty box cutter-style 
snap blade knife for cutting down panels.

Tools involved in the wrapping process can 
be a pretty long list, and many of them come 
down to personal preference. Here’s what I’ll 

Rolls of color-change media can be purchased from a wholesaler and are ready to install.
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ment down the line. Initially, though, you will 
need a large work surface, preferably at least 
5' X 12', with a cutting surface for trimming 
laminated graphics.

You will also need a fast computer, RIP soft-
ware, and design software for creating and out-
putting your graphics. Racks for storing media 
rolls and drying your printed graphics will also 
need to be purchased.

For contour cut graphics, you’ll also need to 
apply application tape. You can purchase or 
build an application tape dispenser, or if you 
invest in an application table, there is a built-in 
bar that you can mount application tape rolls 
on for easy masking. You’ll also need a safety 
straight-edge and heavy-duty box cutter-style 
snap blade knife for cutting down panels.

Tools involved in the wrapping process can 
be a pretty long list, and many of them come 
down to personal preference. Here’s what I’ll 

call a partial list because you’ll need to decide what tools meet your quality and 
efficiency checklist.

For wrap comfort and accessibility, you’ll need a quality rolling wrap chair with a 
cushioned seat and attached tool storage. You’ll also need work platforms, step lad-
ders, taller ladders, and rolling scaffolding.

Your installation tool chest should include squeegees with hard and felt edges, 
rivet brushes, retractable knives with snap blades, blade disposal bins, small plastic 
tools for tight areas, plastic scrapers or specialized tools for emblem removal, scis-
sors or a Snitty, air release tools, heat guns and extension cords, portable propane 
torches, masking tape, cleaning products and lint-free towels, specialty tools for 
concave areas and textured surfaces, wrap gloves, tape measures, and magnets for 
hanging graphics.

PRICING
Getting started in wraps goes beyond the actual installation and equipment as you 
also learn to price yourself to make a profit. When we’re quoting a wrap project, the 
pricing gets broken down into three areas – graphics, design, and installation. Each 
of these areas directly affects how you price your wraps.

You’re in business to turn a profit, so you must know your material and overhead 
costs and price your graphics to cover these costs and make you a living. We’ve cre-

Large vans and vehicles with deep recesses can be tricky to wrap. Education and hands-on training ensure a quality install.
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ated a spreadsheet for all our graphics and signs that breaks the pricing down by the 
square footage, with price breaks for larger projects.

When pricing installation, there are a couple of approaches. Some companies 
price out installation based on a per square foot rate – for example, if an install is 
200 total square feet, then it’s a flat price per square foot whether it’s a box truck 
or a sedan.

We price our installation based on the vehicle itself and its unique obstacles. We 
can wrap a large box truck or trailer as fast or faster than a small sedan in some 
cases simply because we’re dealing with fewer obstacles and less trimming.

After so many years of installing, we have a pretty good idea of how long it will 
take to wrap a particular vehicle. If we’re wrapping a utility bed truck with many 
small boxes and handles that will require a lot of trimming, then we take that into 
account and add a little more time. If it’s a Sprinter van, we’ll consider the concave 
areas and small rubber trim areas that need to be trimmed out.

GRAPHICS
As I mentioned, there are three considerations when pricing out our wraps. I wanted 
to look at each topic and review how important they are as you venture into the 
wrap industry.

There are so many different manufacturers and media types on the market that 
it can get overwhelming as you consider your options. My best advice is to choose 
quality and consistency and avoid cutting corners.

A good quality wrap media will not only be 
easier to install, but it will look good and last 
longer. The quality of your wraps will build 
your reputation; don’t risk it on inferior prod-
ucts to make an extra dime upfront because it 
will cost you in the long run.

We have a problem with graphics quickly 
browning on horizontal surfaces in our area, so 
we use 3M 8548 gloss non-PVC laminate on 
all our vehicle wraps. Through trial and error, 
research, and testing, we’ve found this to be 
a great product. We pair it with IJ180Cv3 or 
IJ480 wrap media for most of our jobs.

Check out different manufacturers and try 
out other materials to see what media you 
like working with; once you find media you 
like, I recommend sticking with it to create 
long-term consistency in media type and color 
output.

Wraps are not only long-term investments; 
sometimes, a customer needs a short-term ad-
vertisement where a transit media or material 

with a temporary adhesive is the best choice. 
Or you might have a project where a reflec-
tive or metallic film is required. Be sure you 
know your options, understand how adhesive 
differences will affect your installation and re-
moval and consider material costs to meet the 
customer’s needs and budget.

DESIGN
If you choose to go full-service with your wraps, 
meaning you’ll be doing all the graphic design 
in-house as well, then you need to educate 
yourself on effective wrap design. Look at ex-
amples of other designers and note things you 
like or don’t like about them.

Commercial wraps must meet the customer’s 
needs. The design should not only be effective 
and professional, but it should also reinforce 
the company brand. Take the time to learn 
your printer’s color output and create custom 
color charts in addition to Pantone charts for 
the customer to choose from.

We price our installation based on the vehicle itself and its unique obstacles. We can wrap a large box truck or trailer as fast or faster than a small sedan in some cases.
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with a temporary adhesive is the best choice. 
Or you might have a project where a reflec-
tive or metallic film is required. Be sure you 
know your options, understand how adhesive 
differences will affect your installation and re-
moval and consider material costs to meet the 
customer’s needs and budget.

DESIGN
If you choose to go full-service with your wraps, 
meaning you’ll be doing all the graphic design 
in-house as well, then you need to educate 
yourself on effective wrap design. Look at ex-
amples of other designers and note things you 
like or don’t like about them.

Commercial wraps must meet the customer’s 
needs. The design should not only be effective 
and professional, but it should also reinforce 
the company brand. Take the time to learn 
your printer’s color output and create custom 
color charts in addition to Pantone charts for 
the customer to choose from.

You need to also learn how to design a wrap from an installer’s standpoint – ob-
stacles and planes of the vehicle need to be considered as to how they will affect the 
installation. A well-thought-out wrap design will make an installation faster and 
more profitable.

INSTALLATION
Whether you decide to wrap vehicles using in-house printed graphics or by contract-
ing with other companies, this is an area where you must do your homework. Ongo-
ing education and hands-on training are imperative to becoming a top-notch installer.

As you first get into the industry, practice on personal vehicles, your shop truck, 
breakroom refrigerator, or file cabinets. Play with material types, heat variances, and 
different tools.

Watch industry videos and then practice the techniques you see. The best way 
to become a good installer is to glean insight from more experienced installers and 
practice, practice, practice. You’ll find your techniques improve, and your installs 
get faster the more you do. GP

CHARITY JACKSON is co-owner of Visual Horizons Custom Signs based in Modesto, California. She has 

been in business since 1995 and has worked in the sign industry for nearly 30 years. You can visit her website 

at www.vhsigns.com.

While we print in-house, we also do installation work for other companies. These vehicles received door wraps as part of a Wrapify campaign.
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Above: The raised logo on this podium, 

made from ¼" acrylic with a surface of 

metallic polyester graphic film, looked so 

much like brushed aluminum that once 

installed it, I could hardly tell the differ-

ence. ±�ll images courtesy 5ick @illiams² 

Right: The graphic film we used, with a 

brushed aluminum appearance, is o\ten 

used \or truck lettering and so \orth, but 

works well \or laser cut graphics.

Several of the jobs passing through the shop 
lately, and done completely in our shop, 
were required to have brushed aluminum 

finishes, or an imitation of the same. The ways 
we tackle these metallic surface effects, without 
expensive equipment or subcontracting, may be 
of interest to other sign makers and graphic folks 
out there. So, for this month’s Shop Talk, let’s look 
at in-house brushed metal or brushed aluminum 
finishes for letters and logos that any sign shop can 
accomplish, both in real metal and plastic made 
to look like real metal.

BRUSHED METAL FINISHES – 
SIMULATED AND REAL
CREATING A STYLISH LOOK FOR LETTERS AND LOGOS
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One of our clients needed two 
projects done. One was a set of up-
per- and lowercase plate aluminum 
letters (¼" thick), which we could 
cut easily enough, but producing 
a professional brushed aluminum 
finish in-house, in real metal, was a 
question mark. Belt sanding with a 
handheld sander had failed us before, 
but wanting to do the job totally in-
house, we would have to come up 
with a way to do it.

Their other project was a logo in-
volving many letters and a few small 
graphic elements, which was to be 
mounted to the front of a speaker’s 
podium in their training room. This 
project did not have to be real metal, 
and, in fact, would be best made in 
a lighter material so the many parts 

could more easily be secured in place 
with glue or double-sided tape, and 
the cost would be less. 

Both jobs needed to be about ¼" 
thick. The real metal lettering would 
be cut on a waterjet from 5052 un-
finished plate aluminum and then 
“brushed” and clear coated. The podi-
um display would be cut on a laser in 
white ¼" thick acrylic, which would 
first be covered with “brushed alumi-
num” self-adhesive graphic film often 
used for truck lettering. This film can 
be used outside or inside and can be 
plotted. But this time, a sheet of this 
metallic graphic film was applied to 
plain white acrylic before any laser 
cutting was done. The transfer tape 

BRUSHED METAL FINISHES – 
SIMULATED AND REAL
CREATING A STYLISH LOOK FOR LETTERS AND LOGOS

With the transfer tape still on each part, to get the edges to look like aluminum, the edges are given a light but overall 

coat of aluminum colored spray paint.

The trans\er tape used to apply the sheet o\ film 

is left on while the laser does its work.

GP_FEB22-ADS.indd   27 1/17/22   11:45 AM



GRAPHICS-PRO.COM 2 0 2 2 F E B R U A R Y  G R A P H I C S  P R O 2 92 8 G R A P H I C S  P R O  F E B R U A R Y  2 0 2 2 GRAPHICS-PRO.COM

SI
G

N
AG

E 
&

 P
R

IN
TI

N
G

S H O P  TA L K

was squeegeed firmly in place and left on the surface 
for the step of laser cutting.

Today’s metallic looking graphic films are really 
good, and quite realistic, but after laser cutting the 
parts, their edges would certainly not look metallic. 
So, leaving the transfer tape on all pieces after laser 
cutting, all the pieces were placed face up on a scrap 

sheet of corrugated plastic and a 
light coat of silver spray paint was 
applied to the edges. Spraying was 
done from all directions, with care 
being taken to ensure nothing was 
missed including the insides of let-
ters like O, R, P, and so forth. 

The final “all aluminum” look 
was quite convincing, yet all these 
simulated metal parts made from 
¼" thick acrylic were super light-
weight and easily secured in place 
with double-sided tape. On the 
jobsite, we used laser cut poster 
board pattern for accurate place-
ment of each piece and there were 
quite a few pieces.

The other part of the project 
required a partial sheet of plate aluminum, ¼" thick, which the real metal 
lettering would be cut from. But, before any cutting was done, the sheet 
was sanded with fine 220 grit sandpaper, using a random orbital sander, 
to take out any surface scratches and give the sheet of aluminum an evenly 
etched look with no real pattern at all. 

Then, using a maroon Scotch-Brite pad stapled to a small piece of lumber, 
a pattern of fairly straight strokes was produced simply by hand, pressing 
down hard on the Scotch-Brite pad and keeping each hand stroke straight 
and horizontal. The look was pretty convincing and would be more so once 
these small letters were cut out.

Here is where I made one mistake, however. After sanding and grain-
ing the sheet, I covered it with HP lettering vinyl to protect it from any 

visible scuff marks the waterjet 
pierces might make when cut-
ting out the parts. In the end, 
this step was not necessary and 
just made more work of having 
to remove the vinyl, which is 
green colored in the pictures. 

After cutting, our plate 
metal letters were drilled and 
tapped from behind for stud 
mounting. Having saved the 
scrap sheet these letters were 
cut from, a final brush pattern 

Above: This close-up shows the spray painted 

“metal edges” of each piece and the convinc-

ing \aux finish o\ each letter and logo element. 

Right: For our set of real plate aluminum let-

ters, with a ¿brushed aluminumÀ finish, the 

process was started by random orbital sand-

ing our ¼” thick raw material, then by hand 

creating an amount of directional grain with a 

6cotch·�rite pad stapled to a wooden block.

Left: A poster 

board pattern, 

also cut on the 

laser, is used to 

align all these 

small parts ac-

curately. 

Right: Double-sided foam tape, 

plus very small drops of clear sili-

cone, are used to adhere our faux 

“brushed aluminum” lettering to 

the \ront o\ the podium.
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was put in the letters with the same 
board covered in Scotch-Brite, by 
merely dropping each letter back in 
the hole where it came from, and sev-
eral firmer strokes on the faces of each 
letter made the straight grain brushed 
metal finish a bit more visible. 

Very small nuts were placed in each 
hole before inserting a letter, so the 
letters would be slightly raised above 
the surface of the sheet. The final look 
was very much like they might have 
looked if grained with a “Time Saver” 
deburring and surfacing machine. 
But those wonderful machines cost 
nearly $200,000 and are not going 
to be found in any commercial sign 
shop I know of. 

I was pleased with the look we could 
achieve with a block of wood and a Scotch-
Brite pad. My powder coating fellow put 
a heavy coat of clear over them, but the 
thinner the clear coat the more the brushed 
finish will show and reflect light. They 
still looked OK, and our client was very 
pleased with them after stud mounting 
them on their wall, though the area on 
the wall where they went was poorly lit.

Another simulated metal finish we had 
to produce lately, though this time on real 
metal, was a chrome look on a logo and 
set of letters that had to be installed in 
our local county courthouse. In the hall-
way of the second floor were some pol-
ished stainless-steel letters that someone 
had installed years before. They basically 
looked like chrome plated metal against a 
medium gray section of wall above large 
plate glass windows. 

Our job was to produce a waterjet cut 
set of letters and a “county seal” logo, in-
cluding a dimensional five-pointed star, 
most common in the Lone Star State. 
These would go on an adjoining wall and 
needed to have a very similar look. Our 
small sign shop had no real way to produce 
these parts in polished stainless steel. But 
we could copy the look of chrome with 
powder coating, and the powder coating 
shop is right across the street.

The letters were 

held stationary by 

dropping in the 

matching voids 

in our scrap ma-

terial. Very small 

nuts were set in 

the holes to raise 

each letter above 

the surface of the 

sheet.

The final grain was created \rom making several straight·line strokes with our 6cotch·�rite block, while applying firm 

downward pressure. 

Left: To protect our sheet \rom piercing scu\\s \rom waterfet cutting, the material was temporarily covered with vinyl, but 

this step was likely not needed. Right: The set o\ letters was waterfet cut, and then we had to remove the protective vinyl.
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Above: With a maroon Scotch-

Brite pad, we could get a me-

dium to fine grain o\ brushed 

aluminum look, but we might 

have gotten even more texture 

with more coarse grit pads. 

Top right: �ere is the set o\ 

brushed grained letters be-

\ore going to the powder coat-

ing shop \or a clear topcoat. 

Right:  The letters were stud 

mounted onto an interior wall, 

but lighting in that area was a 

bit poor.

In recent years, powder manufacturers have cre-
ated some powder that simulates chrome very well, 
but for durability outside the finish, needs a clear 
coat to keep it protected which dulling the effect 
a bit. However, this logo and set of letters were 
going inside, and did not need a topcoat, which 
meant the final look would be even better.

This simulated “chrome” finish is not expen-
sive, and no more trouble to spray than any other 
powder, so there is nothing unusual about the 
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process, and any powder coating shop 
could do it. 

The cost was way less than polished 
stainless steel, but once installed our dis-
play had a very high-end look. The final 
product was much approved by our cli-
ent, which is our local county sheriff, so 
we certainly don’t want to let him down. 

So, whether we need to produce a 
straight grained brushed aluminum fin-
ish in a set of shop-made metal letters 
on a budget, a similar look in completely 
faux aluminum letters, or even get a finish 
much like polished stainless or chrome 
on parts we also made in our sign shop, 
there are ways to get these things done. 
Keeping more of the work in-house helps 
our bottom line and our timeline. And 
we know our clients will be happy with 
the results and their reasonable costs. 
What’s not to like about that? GP

RICK WILLIAMS owns Rick’s Sign Company, a 

commercial sign shop in Longview, Texas. He has 

been in the sign industry since 1973 and has been 

a contributing editor to Sign Business and Sign & 

Digital Graphics since 1986. Contact Rick via email 

at ricksignco@aol.com.

The Time Saver 

machine is made 

for deburring and 

graining of plate 

metal objects. 

Few sign shops 

could afford this 

equipment but 

can create real 

brushed alumi-

num letters by 

hand.

�nother metal fin-

ish we needed to 

use lately, was a 

type of chrome or 

polished stainless 

look, which in this 

case was done 

with a fake but 

quite convincing 

powder coating 

“chrome” powder. 

This “R” is a 

sample of one of 

the smallest sets 

of real metal let-

ters we’ve ever 

had to work with.  

The size was 

only 1.25” tall by 

.25” thick and 

was actually stud 

mounted.
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THE NEW AND IMPROVED 6 
CORE DISCIPLINES OF SIGN DESIGN
HOW TO APPROACH THE DESIGN OF A SIGN FOR READABILITY

Are you in the sign business? Do 
you help your customers get their 
message out to their viewers (audi-

ence, team, students, employees, custom-
ers, prospects, etc.) by helping them create 
banners and placards and vehicle graphics 
that have their logo and additional infor-
mation incorporated into the design?

Remember, signage means commu-
nication. Design enhances the delivery 
of the communication. No matter how 
great the design may be, if it doesn’t com-
municate a message, it’s only a design.

Words are optional. Symbols can 
count as signage if an intended message/
thought/warning/direction/condition/
identification/etc., is being communi-
cated.

Below I have listed my 6 Core Dis-
ciplines of Sign Design, and you may 
notice that my approach to each is a bit 
different and deeper than what you have 
previously considered. I try to consider 
the psychographic effectiveness of sign 
design and when possible, I try to incor-
porate elements that might appeal to the 
viewers cognitive behavior.

Designing a safety or warning sign for 
use at Disneyland requires a much dif-
ferent approach than designing the same 
safety sign for inmates at a prison.

DISCLAIMER
Yes, I know there are always a few excep-
tions that cross the lines and make the 
design a very challenging project that 
sometimes has no options but to ignore 
one or more of the rules. I get it, I’ve 
been there, and one of those challeng-
ing exceptions can sometimes be the cli-
ent themselves who insists on having a 
50% halftone of their mission statement 
superimposed behind their ornate old-

English, all-caps font selection, in red on 
medium blue with yellow shadow box 
outlines. 

Yes, sometimes the customer’s wishes 
override all common logic and design 
sense, and you give them the best of what 

can be done with that hot mess of clutter 
they have dumped onto your plate. But 
this is not about those situations or how 
to work with a closed-minded client. 
That is a whole other article for a whole 
different case study. We are focusing on 

Here we are making sure that the primary message is seen, read, and understood. Or it may be used to call 

out an I�. It gets your attention§ (ote¤ I did not adfust the kerning on these examples. ItÂs close, sort o\, but 

for your sign design, kerning should always be mentioned, or applied as it occurs so that it is not over-

looked. (All images courtesy Matt Charboneau)

Perhaps the message is absolutely needed on the sign, but not necessarily the focus of the message. This 

might be used \or listing details or services, or benefits o\\ered.
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designing signs that are readable at the ini-
tial and optimum distances regardless of 
which sign type you are creating.

THE 6 CORE DISCIPLINES OF SIGN 
DESIGN

• Define the sign type by identifying 
its purpose — what is it communi-
cating?

• Identify the read distance — initial 
and optimal?

• Determine the best size and place-
ment of the sign — can less say 
more?

• Design with appropriate contrasts
• Choose a font that’s readable from 

the initial and optimal distances
• Create a layout that promotes the 

proper importance and flow of the 
message(s)

See, I told you it would be a little differ-
ent than what you may have seen in the 
past. This is something I’ve fine-tuned as 
a sign designer over the last 37 or so years. 
You may have seen a list like this online 
where companies offer up “solutionary” 
ideas to help their customer understand 
that there is more to sign design than just 
“a good-looking sign,” but my approach 
focuses on the core of design disciplines 
that will provide the customer with a sign 
that actually does what it is intended to do. 

Industry differences have no effect on 
proper sign design. Cars, boats, houses, 
dogs, cats, cows, rugs, hats, pillows or 
beds, effective signage must follow the 
core design disciplines that consistently 
produce effective sign designs. Period. 
And, I have noticed that 99% of most sign 
design fails have to do with designs that do 
not consider the appropriate read distance, 
contrast, or font choice for effective sign 
design. There’s also “thought count,” in 

which signs try to convey too many ideas 
to the viewer. No single core element is 
more important than the others as they all 
must be implemented for the sign design 
to do its job.

By the way, I can only presume that you 
are reading this article because A) You are 
a designer and you are constantly trying 
to improve your process, or B) You have a 
designer who is described as A. The good 
news is that this article is exactly what is 
needed to help guide the creative mind in 
the right direction for effective sign design.

DEFINE THE SIGN TYPE & PURPOSE
Sign design starts with an overall under-
standing of the purpose and function of 
the sign.

To do this effectively you must look 
at your customer’s needs, opportunities, 
and challenges from a unique mindset that 
considers more than just the upfront obvi-
ous considerations. 

Ever had to consider weather as an envi-
ronmental condition that must be overcome 
for an effective sign design? Ever designed a 
sign that is regularly obstructed by light fog 

THE NEW AND IMPROVED 6 
CORE DISCIPLINES OF SIGN DESIGN
HOW TO APPROACH THE DESIGN OF A SIGN FOR READABILITY

can be done with that hot mess of clutter 
they have dumped onto your plate. But 
this is not about those situations or how 
to work with a closed-minded client. 
That is a whole other article for a whole 
different case study. We are focusing on 

Perhaps the message is absolutely needed on the sign, but not necessarily the focus of the message. This 

might be used \or listing details or services, or benefits o\\ered.

(otice how the thin stroke \ont tones down the visual impact over the heavier \ont.

�or the sign industry, this techniwue is rarely used but could be i\ needed. 2er\ect \or a screen display, a display ad 

and¯or websites, e·�yers, etc. The letters are visible, readable, and clear. They fust have so little contrast with their 

backgrounds that they are di\ficult to read wuickly or practically.
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or falling snow? Taking that into account 
would direct the sign designer to avoid 
the color white (duh!) and to work with 
extremely contrasting primary colors to 
frame the message so that it’s “as readable 
as it possibly can be for the conditions.” 

Or it may take some selling skills on 
your part to increase the client’s budget 
to consider an illuminated sign option, if 
so allowed. This is just a small example of 
what it looks like to have a sign designer’s 
mindset. Always looking beyond the obvi-
ous, asking the questions that nobody else 
is thinking about for the benefit of maxi-
mizing the effectiveness of the sign’s design.

IDENTIFY THE READ DISTANCE
There are some very specific “awareness-
es” that must take place in recognizing 
what the differences are between design-
ing a PULL TO OPEN door sign that’s 
mounted on the door glass at eye level, 
and viewed initially from 72" away, and 
optimally viewable from 36" and again 
at 18" away (arm’s length distance). No-
tice I mention the two optimal viewing 
opportunities. These viewing opportuni-
ties are most often overlooked because it’s 
such an easy sign to hold in your hand 
and view. It’s so easy, yet it’s on almost 
every door, and is missed by almost ev-
erybody, including me.

Why does this happen? The design 
may have been pretty good, with lots of 
contrast, but when stickers of other im-
portance are placed all around the PULL 
TO OPEN sign, it becomes lost in the 
visual clutter, and suddenly the sign that 
appeared to be readable, is nothing more 
than additional visual clutter on a very 
busy entry door — its message largely 
lost, and heeded only by those whose 
muscle memory is already familiar with 
the door’s operation.

DETERMINE THE BEST SIGN SIZE & 
PLACEMENT
What was missed? The sign being too 
small? The sign’s color or was it possibly 

the sign’s placement — and the allow-
ance of other stickers to interfere with the 
readability of the sign. An unobstructed 
surrounding environment is so very 
important for a sign like this to remain 
readable.

CONTRAST, FONT & LAYOUT
These are now moot points. No matter 
how successful your design is, if it’s lost 
in the environment due to crowded con-

ditions by being surrounded by a sea of 
visual clutter, then it’s still considered a 
sign project that wasn’t successful.

Creating a sign like this would solve the 
visual clutter problem and provide a more 
visible, more readable, and more effective 
sign. Understanding what questions to 
ask for the variety of sign opportunities 
you may come across only comes from 
placing yourself mentally or physically (if 
possible) in the environment where the 

Here is an example of using bold contrast with heavy fonts. Keeping the fonts all the same size and crowding the 

signÂs \ace with copy is a style IÂve seen more o\ lately. It is a style that o\\ers its own intangible meaning and \eel-

ings; however, I do not recommend it for commercial signage as the message is lost within the “stylization” of the 

sign’s copy. It should be the other way around.

Here I have chosen a font that adds a bit of visual interest, along with adding empty blank space around the 

copy so that it’s more readable. I also used color to help the thinner font stand out more without being too over-

powering.

I still felt the “when” message was not standing out enough. Even for this exercise the “when” is almost as important as 

the “what” or “who” that might be advertised. Adding the darker bar helps the “when” stand out more, while also provid-

ing a better break between thoughts \or the viewer. 6ome viewers may miss the detail o\ the doors opening at � p.m., and 

that is an example of the things to consider when deciding which bits of copy and info will clutter the message or clarify it.
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sign is being installed to determine the best 
options for the sign. This, along with ask-
ing questions, will provide you and your 
designers with valuable insight as to the 
best solution for your customer.

The point I am making is that a PULL 
TO OPEN sign design approach is much 
different than the design for a billboard 
on an interstate highway. Two completely 
different disciplines, skillsets and consid-
erations, yet so many times we see the core 
basics of sign design ignored, leaving un-
knowing clients with signs that “look so 
awesome” but fail when it comes to per-
forming the job it was originally designed 
to do. 

SIGN TYPE CATEGORIES: A QUICK 
OVERVIEW
A sign’s effectiveness is governed by both 
the visual and psychographic effects the 
sign has on the viewer. The sign’s purpose 
must first be identified before it can be 
designed effectively. Once the type is de-
termined, keeping your design within the 
sign type category is key to it being ef-
fective.

• Warning & Safety Signs: Created 
with bold contrasting colors and 

clear, recognizable text to focus the 
viewer on the importance of the mes-
sage. STAY OUT, DANGER, PULL 
TO OPEN, WARNING - HIGH 
VOLTAGE, STAY ON PATH, FIRE 
EXIT, etc.

• Informational, Regulatory or Com-
municative Signs: Instructs us to 
stand here, do this, form a line here, 
or it might even explain the history 
of what you are viewing, or inform 
you of what happened on this site 
100 years ago. Imagine a tour guide 
providing you with details of an ex-
hibit; that is what an informational 
sign is like. These signs tend to of-
fer up a lot of information, yet they 
still qualify as a sign provided it still 
meets the criteria of the rules of sign 
design.

• Advertising Signs: Different from 
informational signs because they 
typically include a call to action. 
This can be thought of as the busi-
ness owner standing on the corner, 
screaming out the items his company 
offers to people as they walk past the 
business. The message is telling the 
viewer to “come on in” or “sale starts 

Saturday” with “the lowest prices of 
the year.” Clarity and readability are 
of utmost importance, as critical as it 
is for safety signs. The more thoughts 
you have on the sign, the less ef-
fective each thought becomes. Too 
much information with not enough 
open space and bad flow creates an 
ineffective sign. 

• Identification Signs: Mark, label, or 
indicate what or who is operating 
within this building or structured 
area. Logos are typically part of this 
category as they can provide a host 
of information in one simple iconic 
graphic. It might also be a sign that 
is as simple as a number or letter 
mounted to a wall, such as a building 
ID sign at an apartment complex.

NOTE: Yes, there are other sign type 
categories that are specialized and fit into 
non-typical industry needs. The sign types 
I have listed cover the primary types dealt 
with in day-to-day commercial and electri-
cal situations.

If there were two key aspects to re-
member for effective sign design, they 
would be contrast and readability. If you 
remember this when that occasional, im-
possible, closed-minded client insists that 
you include the family crest, the fiery bird 
graphic and the tattoo-looking intertwined 
barbed-wire and red roses design into their 
new ice cream shop sign, you can do so 
with confidence that at least it’s readable 
from 300 feet away. You may not be sure 
of what is being read, but if it’s readable 
from the right distance, and the message 
they intended to communicate is clear, 
then you’ve done your job! GP

MATT CHARBONEAU started his career in the sign 

industry in 1985 as Charboneau Signs. In 2017, he pub-

lished the Pre-Sale Sign Survey Field Guide. In 2019, he 

started Storm Mountain Signs and the Sign Design In-

stitute. Contact him at Matt@stormmountainsigns.com; 

www.stormmountainsigns.com; and 970-481-4151.

ditions by being surrounded by a sea of 
visual clutter, then it’s still considered a 
sign project that wasn’t successful.

Creating a sign like this would solve the 
visual clutter problem and provide a more 
visible, more readable, and more effective 
sign. Understanding what questions to 
ask for the variety of sign opportunities 
you may come across only comes from 
placing yourself mentally or physically (if 
possible) in the environment where the 

Here I have chosen a font that adds a bit of visual interest, along with adding empty blank space around the 

copy so that it’s more readable. I also used color to help the thinner font stand out more without being too over-

powering.

I still felt the “when” message was not standing out enough. Even for this exercise the “when” is almost as important as 

the “what” or “who” that might be advertised. Adding the darker bar helps the “when” stand out more, while also provid-

ing a better break between thoughts \or the viewer. 6ome viewers may miss the detail o\ the doors opening at � p.m., and 

that is an example of the things to consider when deciding which bits of copy and info will clutter the message or clarify it.
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A monochromatic image can some-
times be a better choice than color 
for a specific purpose. Perhaps the 

picture needs to look old, like it’s been sit-
ting in drawer for the past 80 years. Maybe 
the image requires the dark black shadows 
and strong highlights for the dramatic look 
of a “cine noir” movie of the late 1940s. 
Then again, maybe it needs the grainy 
mistiness that only a monochrome can 
provide. And most commonly, the image 
may have to be prepared for a monochro-
matic publication. Whatever the purpose, 
you will no doubt sooner or later encoun-
ter the necessity of discarding the color in-
formation to produce a black-and-white or 
monochromatic image. As usual, I’m us-
ing Adobe Photoshop CC to demonstrate 
these techniques.

MONOCHROMES
A monochrome image is composed of a 
range of a single color. It could be black 
and white and the various shades of gray 
that are the product of total desatura-
tion, or it could be a brownish tint like 
a sepia tone, or any other color from the 
millions of colors in the extensive RGB 
color gamut.

GRAYSCALE
Even though the image may look spec-
tacular in color, discarding the color in-
formation by changing its color mode 
from RGB to grayscale usually produces 
less than perfect results. So too, using 
the desaturation adjustment often doesn’t 
produce the best results either. Ordinary 
desaturation can undermine the overall 

tonal quality giving the image a flat, lack-
luster appearance as in Fig. 1.

There are several methods for creating a 
better monochrome. Each method has its 
own advantages. If one technique doesn’t 
produce brilliant results, try another. All 
offer more control and the ability to pre-
view the tonal range before discarding 
the color information.

THE BEST CHANNEL
Initially, this technique is quite easy 
because it involves looking at each 
color channel and determining which 
one looks the best. After the decision is 
made, a little bit of layer finagling will 
make the image pop. 

Start by opening a full-color RGB 
image. Choose Window > Channels to 

FULL COLOR TO MONOCHROME 
TECHNIQUES FOR PRODUCING THE BEST MONOCHROMES FROM COLOR IMAGES

Fig. 1: *rdinary desaturation can undermine the overall tonal wuality giving the image a �at, lackluster appearance. ±�ll images courtesy 6tephen 5omaniello²
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display the Channels panel. Scrutinize the 
color channels by pressing Cmnd/Ctrl-
1 to observe the red channel. It should 
appear as a grayscale. If the channel is 
tinted red, choose Photoshop (Mac) or
Edit (Win) > Preferences > Interface and 
uncheck the Show Color Channels in the 
Color checkbox.

Press Cmnd/Ctrl-2 to see the green 
channel and Cmnd/Cntrl-3 to see the 
blue channel. Compare the three color 
channels then click on the one that looks 
the best. In this case, it’s the green chan-
nel. (Fig. 2)

COPY THE CHANNEL
In the Channel panel Options menu, 
choose Duplicate Channel to display the 
Duplicate Channel dialog box, shown in 
Fig. 3. In the Document pop-up menu, 
name the channel. Choose New for the 
destination to save the channel as a sepa-
rate document. From the Image menu, 
choose Mode > Grayscale to convert the 
image from an Alpha Channel to a gray-
scale. Display the Layers panel. Click the 
background layer and choose Duplicate 
Layer from the Layer Options menu.

TONE AND TINT
From the Blend Mode menu, choose 
Soft Light to enhance the contrast of the 
image shown in Fig. 4. Tint the image 
to slightly warm or cool the image. Go 
to Image > Mode > RGB to convert the 
image’s color mode so that the image 
supports color. Next, go to the Adjust-
ments panel and click the Photo Filter 
icon. Choose a filter from the list on the 
panel or click on the swatch to display 
the Color Picker. After choosing a color, 
drag the slider to control the strength of 
the filter. (Fig. 5)

THE CHANNEL MIXER 
This variation of the color to monochrome 
technique uses the Channel Mixer on an 
adjustment layer to combine values of the 
three color channels into an image with a 
wide tonal range. The advantage of using 
the Channel Mixer technique is its flexibil-

ity. All the controls are in one interactive 
dialog box and each channel’s tonal range 
can be adjusted independently. This tech-
nique also employs a layer mask for even 
more control. Here is a step-by-step guide 
on how to mix channels into the perfect 
monochrome.

tonal quality giving the image a flat, lack-
luster appearance as in Fig. 1.

There are several methods for creating a 
better monochrome. Each method has its 
own advantages. If one technique doesn’t 
produce brilliant results, try another. All 
offer more control and the ability to pre-
view the tonal range before discarding 
the color information.

THE BEST CHANNEL
Initially, this technique is quite easy 
because it involves looking at each 
color channel and determining which 
one looks the best. After the decision is 
made, a little bit of layer finagling will 
make the image pop. 

Start by opening a full-color RGB 
image. Choose Window > Channels to 

FULL COLOR TO MONOCHROME 
TECHNIQUES FOR PRODUCING THE BEST MONOCHROMES FROM COLOR IMAGES

Fig. 1: *rdinary desaturation can undermine the overall tonal wuality giving the image a �at, lackluster appearance. ±�ll images courtesy 6tephen 5omaniello²

Fig. 2: 
ompare the three color channels then click on the one that looks the best. In this case, itÂs the green channel.

Fig. 3: The �uplicate 
hannel dialog box.
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1. Start by opening a color photo-
graph. Go to the Adjustments panel 
and click on the Channel Mixer 
icon. (Fig. 6)

2. Click the Monochrome checkbox. 
By default, the image now appears 
black and white and the red and 
green sliders read 40% and the blue 
slider reads 20%. This produces a 

Fig. 4: From the Blend Mode menu, choose 

Soft Light to enhance the contrast of the image.

Fig. 5: The Photo Filter adjustment tints the image.
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1. Start by opening a color photo-
graph. Go to the Adjustments panel 
and click on the Channel Mixer 
icon. (Fig. 6)

2. Click the Monochrome checkbox. 
By default, the image now appears 
black and white and the red and 
green sliders read 40% and the blue 
slider reads 20%. This produces a 

rather disappointing monochrome. 
(Fig. 7)

3. Drag the sliders to get more punch 
and pop out of the image. Drag the 
red slider to the right to 75%, and 
then drag the green and blue slid-
ers to the left until the image shows 
a good contrast. Drag the constant 
slider to +2 to slightly lighten the im-

age. (Fig. 8) Of course, these num-
bers represent the ideal tonal correc-
tion for this image. Other images 
will require different adjustments.

4. Playing with the sliders a little will 
produce even better contrast. Deter-
mine if the contrast is good by ob-
serving the lightest and darkest areas 
of the image. The highlights should 

Fig. 6: The Channel Mixer adjustment panel con-

trols the RGB values on a monochrome image.

Fig. 7: Initially the Channel 

Mixer produces a rather dis-

appointing monochrome.
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be bright but not blown out. The 
darks should maintain detail.

5. If necessary, click the adjustment 
layer’s layer mask to target it. 
Choose the Brush tool and a me-
dium soft brush from the Options 
bar brush menu. Press the D key to 
set the foreground and background 
color to the default white and 
black. Click and drag over the im-
age to paint the highlights back in.

6. Don’t forget that even though the 
image appears as black and white, 
it was captured in RGB mode and 
should ultimately be converted to 
grayscale. 

BLACK AND WHITE
The Black and White feature in Photo-
shop controls all the characteristics of 
color to black and white conversions in 
one concise interface. It’s like the chan-
nel mixer in that it targets specific ranges 

of the color in the original image and 
adjusts them independently. The differ-
ence is that the targeted colors can be 
combinations of RGB colors. In other 
words, each adjustment is not limited 
to an individual color channel but can 
affect multiple values simultaneously. 
The interface is pretty straightforward.

Open an RGB image (Fig. 9) and click 
on the Black and White icon in the Ad-
justments panel. The image changes to 
a desaturated version of the color im-
age. Drag the individual sliders to ad-
just the brightness percentage of each 
color range. As the sliders are dragged, 
the brightness of each range is affected 
(Fig. 10). Preconfigured brightness and 
contrast values can be applied by select-
ing one from the Preset pop-up menu 
at the top of the panel. These values 
simulate photographic filters or specific 
photo effects. 

If desired, click the Tint checkbox to 

apply a color tint to the image. Drag the 
Hue and Saturation sliders to modify the 
black and white image into a sepia tone 
or another monochromatic color.

The Black and White command works 
only in RGB mode. When the command 
is applied to the image, though it appears 
as a grayscale, it remains in RGB mode 
until it is converted to grayscale.

THE BEST MONOCHROMES
Using any one of the three techniques 
presented here will produce a great mono-
chrome with a minimum of effort. These 
step-by-step processes are designed to 
achieve optimal brightness and contrast 
on a monochromatic image. Remember 
however, that each image is unique in its 
requirements. As in all Photoshop work-
flows, experimentation is the key to pro-
ducing the best results so don’t be afraid 
to play around with the features. 

I hope this article has increased your 

Fig. 8: Dragging the sliders produces more distinct contrast and better tonal relationships.
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understanding of how to achieve a mono-
chromatic image that exceeds your expec-
tations. Don’t forget to tune in for my 
next Digital Eye article in GRAPHICS 
PRO magazine that will show you the best 
techniques to colorize a monochrome into 
a full color image. GP

STEPHEN ROMANIELLO is and artist and educa-

tor who has been teaching computer graphics since 

1990. He is the founder of the Digital Arts program 

at Pima Community College in Tucson, Arizona. 

6tephen is a certified instructor in �doOe Photo-

shop, Adobe Illustrator and Adobe Premier and the 

author of numerous books, articles and media on the 

creative use of digital graphics software. Steve is the 

founder and CEO of GlobalEye systems, a company 

that offers training and consulting in graphics soft-

ware and creative imaging.
Fig. 10: Drag the individual sliders to adjust the brightness percentage of each color range. As the sliders are 

dragged, the brightness of each range is affected.

Fig. 9: Open an RGB image and click on the Black and White icon in the Adjustments panel. The image is 

desaturated.
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Introduction
to @a�finTing
DIRECTIONS TO GUIDE YOURSELF THROUGH 
A SUCCESSFUL SYSTEM          B Y  J D  H A M I LT O N

S I G N A G E  &  P R I N T I N G

W
ayfinding is an integral meth-
od of guiding people from 
one area to another in an un-
familiar place. 

Definition – The basic art of getting 
people from point A to point B. The dic-
tionary defines it as the process or activity 
of ascertaining one’s position and planning 
and following a route. You can look at way-
finding as the visual language of moving 
people through space.

History – Wayfinding is as old as signage 
and has its roots intricately tied to it. It 
dates back to when most people could not 
read, and shops like shoe cobblers would 
hang a large shoe on their building, and 
blacksmiths would hang a carved anvil, so 
people knew how to find them. Ironically, 
wayfinding as a discipline of signage only 
began to evolve as a standalone discipline 
starting in the 1950s, and its importance 
has quickly been rising since.

5 PRINCIPLES TO SUCCESSFUL 
WAYFINDING

• Create an identity at each location: 
This is the tie-in with signage. Your 
final destination needs to be easily 
identified. 

• Use landmarks to provide orientation 
cues: This can either be a physical 
reference, a sign at a location, or an-
other part of the wayfinding system 
that keeps travelers moving in the 
right direction.

• Create well-structured paths: While 
usually well beyond the scope of 
work for signage, architects, builders, 
and contractors should be mindful 
of a safe and open “pathway” for the 
traveler. 

• Create regions of differing visual 
character: Ah, theming and brand-
ing. We will cover this in more detail. 
But all successful systems must have 
directions that are sized appropriately 
and easily read.

• Don’t give the user too many navi-
gational choices: Think of the overly 
complicated instructions back in 
the day by Sears and Roebuck to as-
semble furniture and contrast that to 
the simple instructions by Ikea. KISS 
– keep it simple stupid! 

4 COMMON TYPES OF WAYFINDING
While we could spend a whole series of 
podcasts on wayfinding, in the interest of 

time, let’s discuss four primary types and 
compare and contrast them.

WAYFINDING FROM A VEHICLE
Over the years, it has become more popular 
for tourist and historic main street projects 
to include some type of wayfinding system 
for people in vehicles. These systems need 
to consider that they are read from a dis-
tance and take a traveling vehicle’s speed 
into account. There are many sources from 
the Department of Transportation that dis-
cuss size and best sans-serif font types to 
be used and vary upon the desired read-
ing distance. Often reflective backgrounds 
will be mandated by code. You will often 
see these systems have several sign types of 
varying sizes that are used at thoroughfare 
(where cars are moving at a higher speed), 
smaller signs at stoplights, and special sign 
types in slow-moving downtown/historic 
areas that have the hybrid job of commu-
nicating directions to both vehicular and 
pedestrian traffic. Outskirt wayfinding and 
historic wayfinding in the same system are 
often differentiated by unique sign types. 

Keep in mind that many of these signs 
are installed in right-of-ways, so DOT 
guidelines must be followed. They often 
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will need a stamped engineered drawing, 
and most importantly, utility checks will 
be needed before any installation. I have 
seen a lot of companies underestimate the 
time and expense needed to cover these 
requirements.

PARKS, ZOOS & UNIVERSITIES 
Directions to fun and games or getting to 
that boring English lecture? These projects 
have a lot of creative potential. They also 
often have the unique wayfinding “buddy” 
— the park map — that is usually given 
out with the entrance ticket or the multi-
thousand-dollar tuition bill. These two re-
sources, when created with the same goal, 
can be invaluable to the traveler. Like the 
signage for vehicular traffic, these signs are 
usually exterior but can be smaller since 
pedestrian traffic is moving by foot. For 
both, it is important to design and fabri-
cate with appropriate materials that can 
handle harsh environments, UV rays, and 
regretfully a potential vandal with a can 
of spray paint. 

Let’s use zoos as a fun example of creative 
wayfinding. Often, they will have several 
different exhibit areas. Wayfinding can di-
rect, identify, and expand the experience 
for the traveler. They may have an “Aus-
tralian Outback” area with kangaroos and 
koalas. This area could have an Aboriginal 

carving for a post, so the traveler knows 
they are in that portion of the zoo. An “Af-
rican Safari” exhibit featuring elephants, 
hippos, and lions could have another look. 
The typeface, colors, and size of the actual 
signage should be consistent throughout 
the zoo, but the unique location could be 
modified in several ways to let the visitor 
know where they are. You often see rent-
als available for audio experience, and in 
today’s modern world, apps can be down-
loaded to give cues and background in-
formation along the journey. Wayfinding 
in today’s world is more than just signage.

For universities, you often see modular 
architectural post-and-panel systems made 
of extruded aluminum com-
ponents. These systems are 
designed for modifications 
or additions, featuring the 
school’s colors and logo.

Many state and fed-
eral parks prefer the use 
of HDPE (high-density 
polyethylene) in two-color 
substrates where you CNC 
carve through one color 
into another (often brown 
and white or golden yellow 
and green). This is highly 
durable and very vandal 
resistant.

HEALTH CARE FACILITIES & AIRPORTS
These systems are primarily interior, so 
there is not as much emphasis on the harsh 
environments found in exterior wayfind-
ing. However, ADA (Americans with Dis-
abilities Act) can often be a requirement. 
This can vary from state to state and mu-
nicipality to municipality. So, you need to 
do your research on what is required. Typi-
cally, “directional wayfinding” does not 
need raised copy and Braille, but destina-
tion and room signage will require it. The 
key to a successful system is tying them 
all in with the same colors, fonts, frames. 
Keep in mind, to meet ADA requirements 
on the room signs, you must have high 
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DOWN AND MORE ON THE GRAPHICS PRO FILES. 
TUNE IN TO HIS EPISODE AT http://gpro.link/jd
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contrasting colors, matte (or non-glossy) 
backgrounds, as well as appropriate Braille 
and raised sans-serif copy. These require-
ments could impact the look of the overall 
wayfinding system. 

A lot of work goes into sign types and 
message schedules, and it is imperative to 
pay close attention to travelers coming off 
an elevator and placing the initial wayfind-
ing in a location that quickly and easily di-
rects left or right. Additional wayfinding is 
also found at the end of hallways, and the 
design and installation need to be looked 
at carefully if it is to be wall-mounted or 
hanging.

Airports are a unique situation. There 
is somewhat of a standard found amongst 
airports. They often have large open ar-
eas and concourses. So, wayfinding needs 
to be designed to be easily read at a dis-
tance — often large copy seen in vehicular 
systems. Each airport has its own special 
color scheme and creativity, usually found 
in unique large identification signage go-
ing to concourses, identifying departure 
or arrival gates.

In many state and 

federal parks, you'll 

find ��2� ±high·

density polyethyl·

ene² in two·color 

substrates. The ma·

terial is 
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 carved 

through one color 
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ilton²

GP_FEB22-ADS.indd   45 1/17/22   11:52 AM



4 6 G R A P H I C S  P R O  F E B R U A R Y  2 0 2 2 GRAPHICS-PRO.COM GRAPHICS-PRO.COM 2 0 2 2 F E B R U A R Y  G R A P H I C S  P R O 4 7

CORPORATE & RETAIL
For corporate locations, you can follow the 
guidelines of health care, but the expense 
and amount of wayfinding are not often 
needed. This system in the past was of-
ten handled with a changeable building 
directory that identified which floor to go 

to and another smaller directory of what 
businesses are located on the floor when 
exiting a stairwell or elevator.

As a sign maker, I hated these jobs that 
required updates from a company that 
either formerly created it decades ago or 
went out of business. It was hard for the 

property manager to justify paying the 
price to add one new tenant and even 
more frustrating to do this job as a loss 
leader for potential other work. Most of 
the time, it was a lose-lose relationship 
for both. 

Enter technology! Today there are a va-
riety of interactive electronic directories. 
These not only deliver wayfinding infor-
mation, but they also offer the ability to 
communicate other helpful information. 
Advertising can even be sold, and property 
managers can make these new directories 
into a revenue maker! Time, weather, and 
other info can be communicated. Best of 
all, the property management, after pur-
chasing the unit and having it installed, 
can make their own updates.

Depending on the corporate and re-
tail size and requirements, these systems 
can be static running info on a loop or 
a touchscreen where the visitor can have 
an interactive experience. For example, 
where can I get lunch after my appoint-
ment?

(Images courtesy 

JD Hamilton)
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BANDING & THEMING OF WAYFINDING 
SYSTEMS
Far and away, the biggest change and im-
provement to successful wayfinding sys-
tems involves creative design that projects 
a unique experience for the traveler/visitor. 
This goes across the board for any wayfind-
ing project.

While the primary purpose is to provide 
clear and concise directions from one place 
to another, the visitor can be emersed into 
a themed environment. The primary im-
portance of having easy to read sans-serif 
copy on a contrasting background with 
clear graphics of arrows and directional 
symbols remains. The ability to work with 
unique sign shapes, materials and incorpo-
rate header graphics or logos not only aids 
the visitor in knowing where they are but 
creates a branded image for the company 
or organization that is directing them.

This is the area where successful design-
ers and fabricators can thrive, strut their 
stuff, and deliver a unique and valuable 
product and service for their clients! The 
journey can be the experience. Crafty de-
signers realize beyond getting travelers and 
visitors successfully from point A to B that 
they can create an experience for them. 
This is where interpretive graphics and sig-
nage along the route can fully be directed, 
educated, and immersed in a branded and 
themed environment.

Think of visiting a zoo. Sometimes you 

may come across lion paw prints in the walk-
way, letting you know where you are. Perhaps 
some signage that describes the vegetation 
of Africa explains the habitat. For corporate 
wayfinding, this is a great opportunity to give 
historical milestones of a company’s achieve-
ments. Wayfinding opens the door to express 
and educate more than just directing.

WHERE DO WE GO FROM HERE?
There is no wayfinding to give that di-
rection. With advancements in materials 
and technology, there are sure to be new 
changes that will help people get where 
they want to go. Other media like apps 

may be used on mobile devices that not 
only direct you on your path but in some 
systems may also allow an interpretive ex-
perience on the journey there. Remember, 
the key is “how” to go, not “where” to go. 
Although being in the trenches, we may 
resort to the latter. GP

JAMES DEAN HAMILTON has been writing for NBM 

since 1995. After a decade sabbatical from writing, he is 

back in the saddle. With over 30 years of experience, he 

has vast experience in everything signage and market-

ing£ and �org�o� management¢

(Images courtesy 

JD Hamilton)

EXPLORE HOW DIGITAL 
SIGNAGE CAN PLAY A 
ROLE IN WAYFINDING: 
_ttu¤¯̄ guro¢hing¯�a�finTing
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IRVING, TX
March 10-12

MEADOWLANDS, NJ
July 21-22

CHARLOTTE, NC
September 16-17

LONG BEACH, CA
August 4-6

INDIANAPOLIS, IN
June 2-4

Featuring

Featuring

DENVER, CO
April 14-15

Back with more in 2022!

GRAPHICS PRO EXPO (GPX) gives you access to the awards and personalization, 
apparel decorating, and sign and digital graphics markets, all under one roof. 

Meet with top exhibitors, source hundreds of products, and train with industry experts. 
Registration is open for GPX Irving and GPX Denver! Join us as we kick off 

the year with our first two shows:

Learn more at GRAPHICS-PRO-EXPO.COM

DENVER, CO April 14-15, 2022
Crowne Plaza Denver Airport Convention Center
Connect and engage in person in the  
Mile High City at GPX Denver. 
Registration is open! Register at: g-p-x.com/co

IRVING, TX March 10-12, 2022
Irving Convention Center
Irving, Texas is the perfect venue to kick off the  
GRAPHICS PRO EXPO season. Join us to see new 
products and technologies, and meet with industry experts.
Registration is open! Register at: g-p-x.com/tx
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Learn more at GRAPHICS-PRO-EXPO.COM

Experience GPX in 2022, with more training, 
exhibitors, networking opportunities
and special programs!

Learn about trending topics, technologies, processes, 
equipment, business practices, and more!

Drinx @ GPX: Take a break toward the end of the day at the 
GRAPHICS PRO booth in the expo hall for beer and soft drinks  
in Denver, Meadowlands, and Charlotte.

The Mixer @ GPX: Join us for drinks and hors d’oeuvres! Network with 
peers in a fun, relaxed environment after the expo hall closes in Irving, 
Indianapolis, and Long Beach.

MORE SPECIAL PROGRAMS

MORE NETWORKING

Considered “higher learning,” these classes will take a deep dive 
into advanced techniques and/or the business aspect of running 
a graphics shop.

These classes are geared toward those who are brand new to a discipline 
or have some graphics experience but are looking to learn the fundamental 
techniques and/or add new profit centers in related markets.

MORE TRAINING

Training in the Classroom: Offered in two different skill levels by our exhibitors and 
select GRAPHICS PRO Magazine expert columnists:

Training in the Hall: Select exhibitors will present 15-30 minute in-booth 
demonstrations throughout each day of the expo in the exhibit hall.

Based on the START HERE-level classes at each GPX event, 
but in a focused 101-level, night-school style educational 
conference the evening before GPX Charlotte.

A wraps event for wrappers
by wrappers at GPX Indianapolis.
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F
ume extraction is an essential com-
ponent of most graphic shops. 
Laser cutting and engraving, 3D 
printing, inkjet coding, among 

many other industrial processes, all gen-
erate respirable dust and gases that can be 
toxic at higher concentrations.

Airborne contaminants can include 
both particles (including nanoparticles) 
and gases (including volatile organic com-

pounds), explains Brian Tefertiller, BOFA. 
Exposure to these emissions has the poten-
tial to impact human health, ranging from 
headaches, eye irritation, skin problems to 
occupational asthma. 

“It is important to remove these contam-
inants from the air before it reaches you,” 
says Chau Vo, PAT Technology. “Filtered 
fume extractors pull the contaminated air 
right from the source, filter the contami-

nants out, and return clean air into the 
room.” Fume extraction helps reduce both 
indoor and outdoor pollution, benefitting 
the laser operators and the environment. 

Using this technology not only helps 
maintain a safe environment for employees, 
says Tefertiller, but it also helps to main-
tain productivity by keeping equipment 
free from dust that might otherwise impact 
product quality and machine reliability. 

Ensuring Efficient 
Fume Extraction 
 PROPER INSTALLATION AND LOCATION 
 IS THE KEY TO BEST RESULTS  B Y  J U L I A  S C H R O E D E R
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“Fume extraction should be considered any time there is the potential of 
particles, vapors, or gases being presented into the breathing air of a facility,” 
says Brad Banfill, Purex Inc. To properly specify the correct size and filtra-
tion, Banfill explains it’s important to understand the processes creating the 
fumes and the chemical makeups of those fumes. In many cases it’s best to 
have the safety data sheets for materials being lasered and any other materials 
involved in a process.

DETERMINING THE NEED FOR A FUME EXTRACTOR
“There are two main triggers in determining when a shop needs a fume 
extractor,” says Tefertiller:

• First, employers must assess the risks to health caused by exposure 
to dust and fume in the workplace and take steps to ensure that any 
exposure is prevented or adequately controlled. This requires an as-
sessment by reference to material safety data sheets and occupational 
exposure levels to determine the preventative measures that need to be 
taken, including installation of fume and dust extraction technology. 

• Second, the impact to the product quality created by non-filtered pro-
cesses may increase costs and downtime. 
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Weighing these factors will help to guide 
the user on best practices when installing or 
updating equipment.

“In general, using a fume extractor is al-
ways a good idea as it relates indoor and 
outdoor air quality,” Vo adds. “However, if 
you know that you or your staff are sensitive 
to odors and chemicals in the air and/or 
you want to avoid any conflicts with your 
neighbors who would object to chemicals 
being blown in their direction, the filtering 
fume extractor can help maintain a good 
relationship with those important people 
and make your business run smoothly.” 

Vo encourages purchasing a fume extrac-
tor at the same time as the laser, or other 
type of equipment, to proactively avoid any 
issues from the get-go.

CHOOSING A FUME EXTRACTOR
Fume extractors come in a variety of shapes 
and sizes. When determining which fume 
extractor to go with, it’s important to under-
stand the areas involved, the amount of air-
flow required to pull fumes from a process, 
and any surrounding areas which may be 
affected by the production of fumes, Banfill 
explains. Proper sizing and filter selection 
are important to get the most optimal so-
lution.

“If you know which materials and the 
quantity you will be processing, share this 
information with the fume extractor manu-
facturer and they can help you determine 
the best fit for your application,” Vo says. 
For example, if you know that you will be 
cutting acrylic, a fume extractor with a large 

Most fume extractors 

work best when they 

are kept relatively close 

to the laser, printer, or 

other equipment. (Image 

courtesy BOFA)

SIGNS A FUME 
EXTRACTOR IS 
NOT WORKING 
EFFICIENTLY

Most professional fume 
extractors will have 

alarms to tell you when there 
is a problem. However, Chau 
Vo, PAT Technology, says 
there are two signs that the 
extractor is not operating 
properly:

1. Smoke is not being 
evacuated fast enough 
from the laser enclo-
sure. You should be 
able to see this through 
the glass door of the 
laser. This usually means 
that the dust filters are 
clogged and need replac-
ing. Alternatively, it could 
be a sign that you have 
a leak in the ducting be-
tween the laser and the 
fume extractor. 

2. Odors are getting stron-
ger. This usually means 
that the gas filters are \ull 
and need replacing. As 
above, it can also mean 
that you have a leak in the 
ducting between the laser 
and the fume extractor.

�dditionally, �rad �anfill, 
Purex Inc, says machine op-
erators or other people near 
the process may complain of 
headaches, depending on the 
process and what fumes are 
being created. GP
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capacity for gases would be appropriate.
Some processes are more prone to cre-

ating potentially harmful byproducts and 
should be fully researched when looking 
for the best solution, Tefertiller explains. 
For example, thermal plastic processes 
and solvents can give off volatile organic 
compounds (VOCs), while PVC releases 
hydrogen chloride/hydrochloric acid and 
small amounts of phosgene when lasered 
or thermally processed, both of which are 
highly toxic. 

SETTING UP A FUME EXTRACTION 
SYSTEM
When installing a fume extraction system, 
it’s good to keep in mind the surrounding 
environment. Banfill asks, “Where do you 
want the clean air directed, are there any 
other sources moving air in the surround-
ing area, what voltages and power supply 
are available?” Also, when installing, Ban-
fill says that any hoses or ducting should 
be as short as possible and to keep any 
turns or bends to a minimum, to avoid 
any unnecessary frictional loss.

“Space is usually at a premium,” Vo 
adds. “A balance of size versus perfor-
mance/capacity must be struck. Most 
fume extractors work best when they are 
kept relatively close to the laser or other 
equipment. This limits the length of 
ducting/hose required to connect the laser 
to the fume extractor, according to Vo. 

However, Tefertiller explains that the 
precise design of each system will require 
in-depth analysis of many different vari-
ables to ensure correct mitigation of risk. 
“This detailed research will involve taking 
account of material safety data sheets, the 
makeup and volume of airborne contami-
nants and/or gases given off by the pro-

cess, the type of production machinery, 
whether the process is enclosed, the du-
ration of production, and whether there 
are thermal risks associated with higher 
temperatures.”

Vo says to choose an extractor that has 
an electronic feature, often referred to 
as an “intelligent flow regulator.” This 
feature allows users to initially set the 
fume extractor at the right flow setting 
to evacuate the fumes from the process. 
Then the system automatically maintains 
that flow set-point despite the increasing 
restrictions caused by the buildup of dust 
in the filters. This ensures that you have 
consistent performance throughout the 

When installing your fume extractor, hoses or ducting should be 

as short as possible to keep any turns or bends to a minimum, to 

avoid any unnecessary frictional loss. (Image courtesy BOFA)
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Most professional fume ex-

tractors will have alarms to tell 

you when there is a problem. 

(Image courtesy BOFA)
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The \ume extractor will o\ten be ewuipped with filter monitoring, such as particle counters and ?*
 detection. ±Image courtesy �*��²
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life of the filters and maximizes the 
potential capacity of the filters. 

Proper filter changes are one of the 
most important things to make sure 
fume extractors are running proper-
ly. Banfill suggests keeping stock of spare 
filters so there are not delays when filters 
become saturated or blocked. It is also 
good to check or replace hoses and duct-
ing to ensure there is a clean pathway 
from the process to the fume extractor.

The fume extractor will often be 
equipped with filter monitoring such 
as particle counters and VOC detec-
tion to assist with this. Otherwise, it is 
left to the user to set up the frequency. 
Each process produces a different level 
of fumes; therefore, the life of filters dif-
fers between applications and frequency 
of use. 

Fume extraction maintenance 
checks should be carried out weekly, 
some monthly, and some annually. 
“Regular servicing is also recommend-
ed — in many countries this is a legal 
requirement and it’s important you re-
fer to your local regulatory body for 
specific guidelines,” Tefertiller adds. 

And one last word of advice: Banfill 
encourages users to consult their lo-
cal agencies to verify if there are laws 
or regulations regarding fume extrac-
tion. GP

JULIA SCHROEDER is a freelance writer based in 

Chicago, Illinois. Previously, she held the position 

of digital content editor for A&E magazine. She can 

be reached at hello@juliawritesforyou.com.

PERFORMING MAINTENANCE CHECKS
Most professional fume extractors are de-
signed to run with minimal maintenance, 
but there are some basic things to keep on 
top of, according to Vo:

• Regularly check the ducting/hosing for 
blockages, leaks and to ensure it is con-
nected to the laser and the fume extrac-
tor. (On rare occasions, people have 
run the laser without being aware that 
the fume extractor was disconnected 
from the laser.)

• Check the status of the filters on a 
regular basis. This will help you change 
the filters at the right time and ensure 
that you are running as efficiently as 
possible. 

• Again, keep spare filters on hand so that 
you don’t have to scramble to get re-
placements at an inconvenient time.
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Left: This a common model of an electrical upright compressor with a belt-driven motor and an 80-gallon air storage tank. The uprights take up less space than the horizontal 

models. (All images courtesy Ruth Dobbins) Right: A two-stage belt-driven horizontal compressor, also with an 80-gallon air storage tank. As you can see, this type of compressor 

requires quite a bit more space than the uprights.

Left: This a common model of an electrical upright compressor with a belt-driven motor and an 80-gallon air storage tank. The uprights take up less space than the horizontal This a common model of an electrical upright compressor with a belt-driven motor and an 80-gallon air storage tank. The uprights take up less space than the horizontal This a common model of an electrical upright compressor with a belt-driven motor and an 80-gallon air storage tank. The uprights take up less space than the horizontal This a common model of an electrical upright compressor with a belt-driven motor and an 80-gallon air storage tank. The uprights take up less space than the horizontal This a common model of an electrical upright compressor with a belt-driven motor and an 80-gallon air storage tank. The uprights take up less space than the horizontal This a common model of an electrical upright compressor with a belt-driven motor and an 80-gallon air storage tank. The uprights take up less space than the horizontal This a common model of an electrical upright compressor with a belt-driven motor and an 80-gallon air storage tank. The uprights take up less space than the horizontal 

A fter the last project interlude, it is time to get back to the essentials of our 
business. One of them (something we are receiving a whole bunch of ques-
tions about lately) is the seemingly never-ending topic of the air compressor. 

And it is an important consideration; after all, the compressor is the “heart” of our 
blasting system and the one item that seems to stump most beginners. 

Choosing the right compressor is the most important choice you will make in 
order to work efficiently. If you do not solve this problem adequately, it will come 
back to haunt you in more ways than you may think. The general question is: what 

  

     COMPRESSORS
for BLASTING
on GLASS

BETTER 
HAVE 

PLENTY 
OF AIR
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kind of compressor should I get? This usu-
ally implies that the questioner wants to 
hear a name brand, when they should be 
asking: what type of compressor should 
I get and how much air does it need to 
be able to produce? What’s the difference? 
Well, a big one. 

Let’s take a look at what’s important. 
In order to give you a complete overview 
of the topic, I need to give you a good 
amount of technical information. Bear 
with me, I will try to keep things as un-
complicated as possible, and hopefully it 
will help you choose wisely if you are just 
starting out, or it may help you change 
your current situation to a more efficient 
one. Here we go, and yes, this will be a 
two-part article.

TYPES OF COMPRESSORS
Most people think that a compressor is a 
compressor, but that’s far from true. There 
are at least five different types of compres-
sors available, and knowing about these 
is important. The types are diaphragm, 
piston, rotary vane, rotary screw and coil.

Diaphragm, more commonly known as 
oil-less compressors, are to be avoided for 
our type of work. For the most part, they 
are small and do not put out enough air. 
The larger ones are considered light duty 
compressors and are noisy. Many of the 
known hardware stores carry these types of 
compressors as their low-end “handyman” 
compressors. We have used an oil-less com-
pressor a few times only to find that the 
motors do not hold up for our application. 
After burning up two motors, we decided 
to never use one of these compressors again.

Piston compressors are by far the most 
common type of compressors available 
today. Their cost is relatively reasonable, 
their maintenance cost is acceptable, and 
they are available in many different sizes 
and come in about three different quality 
levels: handyman, commercial and indus-
trial. They require an air receiver, or air 
storage tank, and are available in various 
configurations from vertical, horizontal, 
portable and stationary.

Rotary vane and rotary screw com-
pressors are more high tech and geared 
to large air production while also car-
rying a higher price tag. These types of 
compressors are made for demanding 
industrial applications that may require 
them to run 24/7 and sport a long service 
life. They generally cost two to four times 
as much as piston compressors that pro-
duce an equivalent amount of air, which 
mostly puts them out of consideration 
for glass etchers. However, if you are a 
production studio blasting on a continu-
ous basis, one of these compressors may 
just be what you want. You could blast for 
extended periods of time with consistent 
air flow and on top of that get a compres-
sor that produces little noise. We used 
rotary vane compressors in England for 
our workshops there and were impressed 
by their quietness; you could hardly hear 
them running. We also used rotary screw 
compressors in other European countries 
and here in the U.S.; we were impressed 
with their performance as well, even 
though they were a bit louder than the 
vane models. These compressors use a set 
of twin screws, a male and a female, to 
compress the air instead of pistons.

I do not have much information about 
coil compressors, which are lesser known 
to us, since we have not had the experi-
ence of working with one of them, but 
from what we have read, they also seem to 
be high-quality machines and priced right 
along with the rotary screw compressors.

COMPRESSOR COMPONENTS
Piston compressors are the most widely 
used compressors, so I will concentrate 
on this type here. These compressors 
have three basic components: the motor, 
the pump and the storage tank. All the 
other miscellaneous parts are related to 
those three. The motor powers the pump, 
which pressurizes the air and sends it to 
the tank, where it is stored until it is used 
by the blaster; here is more info about the 
individual components.

After 40 years, 
still the only

 Manufacturer of 
Sandcarving Films 

& Equipment

800-729-9478
www.Rayzist.com
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THE MOTOR
Piston compressors are either powered 

by electric or internal combustion mo-
tors, such as gas or diesel engines. Though 
gas compressors can power a blaster, they 
are not the right choice for just any situa-
tion. They are more expensive than electric 
compressors, require constant attention to 
keep the gas level supplied, and are louder. 
Additionally, they cannot be operated in-
side in a closed environment since they 
give off noxious fumes and are less efficient 
than their electric counterparts. 

The main application for a gas engine 
compressor would be the need to blast 
with an on-site blaster, which requires way 
more air than a pressure blaster. The unit 
would have to be placed on the outside of 
any building, which is not always possible 
with any given job due to the noise they 
generate. Electric compressors are the most 
logical choice. 

There are direct-drive and belt-driven 
motors, which I explain a bit more when 
talking about the pump in the next sub-
section. Electric compressor motors can 
be powered by 120-volt or by 240-volt 
single-phase electricity. There are some 
that run on three-phase electricity, which 
is only available in commercially zoned 

This is a common “handyman” model on two wheels, making it possible to easily move. These 

compressors run on common 110 household current but are generally low in air output. If you are 

on a low budget, you could use two of these low-end compressors and pipe them together.

This is also a common gas engine compressor with small twin storage tanks. The gas tank sits on top of 

the motor and has to be filled i\ you are working \or long periods o\ times. These compressors are noisy, 

smell, and generally output only a fair amount of air pressure (about 7 CFM at 90 PSI).
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areas. Regular household electricity has a range from 110 to 120 volts and 
can power a small compressor. This is because most household circuits are 
only 20 AMPS, and more powerful compressors require at least a dedicated 
50 AMP breaker. Due to the physics of electricity, only relatively low-power 
motors can run on this type of electricity. 

A compressor running on 120 volts will provide enough air for blasting on 
a hobby to light professional level, as long as you do not plan to do a lot of 
carving. For serious blasting professionals, they will not do. For continuous 
blasting on a professional level, you need to choose a compressor with a motor 
that runs on 240 volts, the type of electricity used by electric stoves, dryers 
and furnaces. These outlets are rated at 220 to 240 volts. 

Unfortunately, most households are only equipped with one or two such 
connections, which are ordinarily in use by household appliances and are often 
not located where you could place a compressor. Most home-based shops will 
need to have a separate outlet installed, which also depends on the size of 
the electric service for the dwelling and may require an additional panel to 
be installed. These are things to explore before buying a compressor because 
the cost for new service is not exactly cheap.

THE COMPRESSOR PUMP
The pump is the device that pressurizes the air by pumping it up to a higher 
pressure. It is important to know what kind of pump the compressor you 
choose has. The two types of pumps you most commonly find are belt driven 
or direct driven. Belt driven is the most used model. The most important 
thing you need to find out is how many CFM you will need from the com-
pressor. The more CFM you need, the bigger the motor and the pump need 
to be. Hold this thought, we will pick that 
topic up later. continued on page 94

As you can see, rotary screw compressors are compact 

and neat besides being able to deliver a large amount of 

air at almost no noise level. It’s no doubt on everyone’s 

wish list but carries a hefty price tag ($4K and up).

A much larger unit that needs to be 

towed by a vehicle. We use this type 

of compressor on large blasting jobs 

on construction sites and any on-site 

job where noise is not an issue. These 

engines are loud but deliver all the air 

one could want for any blasting job.
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LASERING GRAPHICS: WHAT YOU 
NEED TO KNOW, PART 2
MASTERING CONTRAST AND GRAYSCALE

This is Part 2 of a two-part series.To 
read Part 1, visit http://gpro.link/p1. 

You just finished lasering a logo for 
a customer project and the logo is a 
prominent centerpiece of the design. 

It doesn’t seem to represent the full-color 
logo the customer provided, and it really 
doesn’t look good at all. The file resolution 
was high enough as I needed to reduce the 
size of the logo. What went wrong?

COLOR TO GRAYSCALE CHALLENGES
If the resolution was high enough that 
the edges of the shapes and letters are 

crisp, it must be how the individual col-
ors translated to the grayscale that is the 
primary issue. So, let’s analyze the graph-
ic. To start with there are blue, red, and 
yellow colors in the logo, in that order. 
The blue and red seem to be almost the 
same shade of gray. The yellow appears to 
blend into the plate you engraved on so 
it doesn’t seem to have lasered out much 
of the plate color and can hardly be seen.
Let’s look at the colors in the original 
logo. Are the blue and red similar shades 
of their color?

In other words, are they similar in their 
darkness or lightness? Yes, even though 
they are different colors their shades of 

the color are very similar. So, when your 
software translated them to grayscale, 
they became almost the same shade of 
gray. Another way of looking at it is that 
there is very little contrast between the 
color shades and thus the shades of gray. 
It is hard to distinguish between the two 
shapes each color represents. So why was 
the yellow shape hardly lasered out? You 
cannot distinguish the yellow shape from 
the background plate color as very little 
lasering took place. As the yellow color 
was a very light yellow, it translated to 
a very light shade of gray. The laser will 
only etch out this shade of gray very 
lightly and in this case, could almost not 
be seen. The shape was not surround-
ed by darker shapes to differentiate it 
from the background and other shapes.
The key word here is CONTRAST. I will 
use the term shapes to refer to each of 
the various different parts of the graphic. 
To easily distinguish one color from an-
other or a particular shape from the back-
ground, whether it’s a metal plate color, 
a wood plaque or two-ply acrylic plas-
tic, contrast between shapes is necessary.

GRAYSCALE
How much contrast is needed for good 
results? The smaller the image the more 
contrast is needed, especially to read the 
text. For very small graphics a black and 
white image may be necessary to make it 
readable or even recognizable.

How do you measure contrast? In 
CorelDRAW, you will find a color palette 
for grayscale, and it will include black 
and white. If you hover your mouse over 
each shade of gray it will indicate the 
percentage of black that the shade repre-
sents. So, 100% is pure black. 0% is pure 

Vector drawn objects 

in various colors. (All images 

courtesy Bob Hagel)
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the color are very similar. So, when your 
software translated them to grayscale, 
they became almost the same shade of 
gray. Another way of looking at it is that 
there is very little contrast between the 
color shades and thus the shades of gray. 
It is hard to distinguish between the two 
shapes each color represents. So why was 
the yellow shape hardly lasered out? You 
cannot distinguish the yellow shape from 
the background plate color as very little 
lasering took place. As the yellow color 
was a very light yellow, it translated to 
a very light shade of gray. The laser will 
only etch out this shade of gray very 
lightly and in this case, could almost not 
be seen. The shape was not surround-
ed by darker shapes to differentiate it 
from the background and other shapes.
The key word here is CONTRAST. I will 
use the term shapes to refer to each of 
the various different parts of the graphic. 
To easily distinguish one color from an-
other or a particular shape from the back-
ground, whether it’s a metal plate color, 
a wood plaque or two-ply acrylic plas-
tic, contrast between shapes is necessary.

GRAYSCALE
How much contrast is needed for good 
results? The smaller the image the more 
contrast is needed, especially to read the 
text. For very small graphics a black and 
white image may be necessary to make it 
readable or even recognizable.

How do you measure contrast? In 
CorelDRAW, you will find a color palette 
for grayscale, and it will include black 
and white. If you hover your mouse over 
each shade of gray it will indicate the 
percentage of black that the shade repre-
sents. So, 100% is pure black. 0% is pure 

white. Each of the grays are a 
percent of black in increments 
of 10%. So, 90% black (I will 
call it 90% gray) is very dark 
and almost black. 10% is very 
light gray and may be difficult 
to distinguish from white.

If you have a graphic with 
lots of different colors that are 
similar shades, they will trans-
late to grays of similar shades. 
The same is true for light col-
ors. They will be hard to dif-
ferentiate.

If a dark color shape is next to 
a light color shape you will have 
two grays that provide good 
contrast, and the two parts can 
be easily distinguished from 
each other. The background to 
text should often be a light col-
or for dark text (often black) to 
stand out, or vice versa. Light color shapes 
in the graphic need to be surrounded by 
dark shapes or they may get lost in the 
background as little etching will occur. 
Colors that are faded from dark to light 
will have the same issue if they are not 
contrasted by the shape to either side of 
the dark portion and the light portion of 
the fade.

HOW MUCH CONTRAST IS NEEDED?
Shades of gray need a minimum of 20% 

differential between shades. So, a 40% gray 
(black) shape needs to sit next to a 60% 
gray shape at a minimum. A 30-40% dif-
ferential is best. To have a graphic appear 
at its best it can be pure black, pure white 
and 2-3 shades of gray.

This might look like black, white, 20%, 
50%, and 80% grays. This assumes the 

white and 20% gray is sur-
rounded by darker shades and 
are not on the outside of the 
graphic. A light gray such as 
20% gray will blend into the 
background as not much will 
be etched out. If it seems com-
plicated, it is. This is why de-
signers should create a black 
and white version and then a 
grayscale version as the first two 
steps. It would prevent having 
to work with a logo that suffers 
from a lack of contrast.

HOW DOES THE LASER ETCH 
A GRAYSCALE SHAPE?
Lasers don’t fire when etching 
pure white, so nothing is etched 
out. With a black object or 

Vector objects changed to various shades of gray and laser on silver acrylic. 

Note placement of color shades.

Vector objects changed to various shades of gray and laser on silver acrylic. 
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shape, the laser fires continuously (or al-
most so), etching out everything. Achiev-
ing shades of gray is accomplished by 
etching out small dots (dithering) leav-
ing tiny bits of background surrounding 
each dot. There are a variety of dithering 
patterns used. You will hear names such 
as Stucki, Jarvis, Floyd Steinberg, Low 
Resolution, Brighten and maybe even 
Standard.

Given the same set of power and speed 
settings, I found Brighten to show more 
detail than most others but be a very light 
etch unless I added more power. Epi-
log’s Standard dithering provides a good 
combination of detail and darkness. Low 
Resolution is very dense and dark with 
the rest producing fairly dense, darker 
images than Standard. You may want 
to experiment using different dithering 

patterns with the same graphic and the 
same laser settings. You may not find a 
great deal of difference. However, in a 
few cases, changing the dithering pattern 
may provide a better, acceptable result.

TOOLS TO HELP FIX CONTRAST 
ISSUES
The larger and more prominent the la-
sered graphic, the more likely you will 
want to fix the contrast challenges. A 
reasonable way to quickly improve the 
contrast between shades of gray is with 
using a Bitmap Editor such as PaintShop 
Pro, Photo-Paint or Photoshop. If your 
graphic is still the original color file you 
will want to turn it to grayscale There are 
many ways to do this. However, there are 
ways to improve the contrast before while 
it is still the original color image.

I am using Corel PaintShop Pro 2020. 
You can adjust the lightness or darkness 
of each primary/secondary color creat-
ing more contrast between colors be-
fore turning the graphic to grayscale. In 
PaintShop Pro, from your top menu, go 
to Adjust > Hue and Saturation > Hue/
Saturation/Brightness. Adjust the bright-
ness for each color you want brighter or 
darker to create contrast between shapes 
next to each other. Then with the colors 
set to Master, reduce the hue down to 0, 
removing all colors.

Another way is to turn the graphic to 
grayscale: Image > Grayscale and then 
Adjust > Brightness and Contrast > 
Highlight/Midtone/Shadows and fur-
ther adjust the brighter and darker tones 
creating more separation between the 
tones.

Left: The tone, not the color determines the shade of gray. Darker tones such as navy blue would become a dark shade of gray, such as 70%. Yellow would become 10% and red, 

a fairly neutral tone, would become 50% black. The larger number of color tones you need to represent, the less distinction between gray tones is necessary. Right: Converting 

from color to grayscale makes the shades vary based on the conversion method. Don’t use a black and white conversion method, the result is far too pixelated.

Left: The tone, not the color determines the shade of gray. Darker tones such as navy blue would become a dark shade of gray, such as 70%. Yellow would become 10% and red, 

a fairly neutral tone, would become 50% black. The larger number of color tones you need to represent, the less distinction between gray tones is necessary. 
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I am using Corel PaintShop Pro 2020. 
You can adjust the lightness or darkness 
of each primary/secondary color creat-
ing more contrast between colors be-
fore turning the graphic to grayscale. In 
PaintShop Pro, from your top menu, go 
to Adjust > Hue and Saturation > Hue/
Saturation/Brightness. Adjust the bright-
ness for each color you want brighter or 
darker to create contrast between shapes 
next to each other. Then with the colors 
set to Master, reduce the hue down to 0, 
removing all colors.

Another way is to turn the graphic to 
grayscale: Image > Grayscale and then 
Adjust > Brightness and Contrast > 
Highlight/Midtone/Shadows and fur-
ther adjust the brighter and darker tones 
creating more separation between the 
tones.

Most better bitmap editors have 
tools to actually change a color. 
Changing a darker blue to yellow 
will likely be equal to changing an 
80% gray to a 20% or 30% gray. 
A dark blue could also be made 
a light blue to provide a lighter 
shade of gray. Remember you 
want to alter each color to a darker 
or lighter color. It’s the shade of 
the color that counts. Any changes 
you make to the whole image such 
as increasing the contrast may not 
offer enough change. You can al-
ways try just adjusting the contrast 
which may work on images with 
only two or three colors.

Even the most basic bitmap 
editors offer contrast sliders. Just 
move the slider to the right and see 
what happens. If you don’t get the 
desired results, you need a more 
targeted method.

Any method that allows you to 
alter colors individually or the 
color’s shade with the original 
color image will work. If the im-
age is grayscale or has been turned 
to grayscale, you need to use any 
method that allows you to change 
the shade or tone of various parts 
of the image.

The last method is by far the 
best method and of course may 
be the most time consuming.

Simple graphics with few colors 
and very high resolution may be 
easy to turn into vector objects 
using your better vector editing 
software such as CorelDRAW or 
Adobe Illustrator. 

There is also specific software available 
for this process. The tools are referred 
to as vectorization tools. Vectorization 
results fall off with graphics that are 
more complicated, include fades and 

are attempted with low resolution files. 
Vectorization tools offer a variety of ca-
pabilities. One that can be very helpful is 
the ability to widen or narrow the range 
of each color shade it includes in creat-
ing the separate objects. You may even 

merge two or more colors by se-
lecting them in the tool to create 
one object that you want to give a 
single color to.

After creating the vector graphic, 
each shape or object can be se-
lected separately or in groups and 
can be altered quickly. Changing 
each shape or group of shapes to 
the desired shade of gray, black or 
pure white would be your goal. 
Vectorization may be more time 
consuming upfront, yet alterations 
to the graphic are much quicker.

I would often combine vector-
izing a logo using this tool with 
replacing an object or two and text 
that did not turn out as expected. 
Drawing tools such as those that 
create circles, rectangles and tri-
angles can be quick and easy to use 
to replace shapes. Typing new text 
if you know the font is also fast. 
If you don’t know the font, find 
one that is close, turn the text to 
curves and you can alter the letters 
as needed.

For clients that I worked with 
continuously or had large orders 
from, I might even trace and re-
draw a logo or event graphic by 
using the line drawing tools. It was 
worth the time for graphics I used 
for many years. GP

BOB HAGEL recently retired after owning 

Eagle’s Mark Awards & Signs for 18 years in 

Southern California. While owning the busi-

ness, he offered a full line of personalized 

products using laser engraving, sandcarving, and full-

color UV direct print on products. Today, he consults on 

starting and expanding personalized businesses and on 

impro�ing production efficiency and wuality¢ �e can Oe 

reached at rjhagel@verizon.net.

The grayscale conversion results show why it is better to begin a graphic 

design in black and white or grayscale.
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Design Terminology 
101: Adobe vs. Corel
MATCHING TERMS FOR SIMILAR FEATURES 
IN BOTH DESIGN PROGRAMS
(All images courtesy Doug Zender)
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CONTROL HANDLES VS. DIRECTION POINTS
A node or anchor point sits directly on a line. Extending out of 
that point are invisible lines that control the shape of the curve 
on either side of it with a data point at the end that allows 
the invisible lines to be manipulated. Corel calls them control 
handles and Adobe calls them direction points. (Fig. 2)

DOCKERS VS. PALETTES 
Both programs include a special variation on dialog boxes to help 
users interact with the software. Corel calls them dockers and they 

R ecently, while visiting the sign 
shop of a friend, I met a young 
lady who had been hired as a de-
signer. She was quite proficient 

with design aspects of Adobe Illustrator. 
This shop, however, used CorelDRAW for 
nearly all its designing, so she had to learn a 
different program. One of her greatest hur-
dles was with the terms used to describe sim-
ilar functions between the two programs. To 
help her with understanding the differences, 
I created the Quick Reference Chart. (Fig. 1) 
In the left column are the basic terms used 
by Adobe Illustrator and the right column 
shows the corresponding description used in 
CorelDRAW — these do not reflect all the 
differences but are the most common terms 
used. Both programs can produce nearly 
identical functions, but the terms used are 
quite different.

Let’s go over some of the differences, be-
ginning from top-to-bottom. To start, in Il-
lustrator, an illustration or design is called 
Artwork, but Corel calls it a Drawing. The 
main difference is that Corel can have mul-
tiple pages while the Adobe counterpart is 
one drawing that simulates several pages.

CURVE VS. PATH
Though both programs can draw various kinds of lines, Adobe calls 
them paths and Corel calls them curves. They are the same thing. 

NODES VS. ANCHOR POINTS 
Along a curve object, there are certain points that control its 
appearance. In Corel, they are called nodes and Adobe calls 
them anchor points. They are the same thing. A future article 
will look more in depth at their function and manipulation to 
modify an object. 
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are called palettes by Adobe. There are slight differences, 
but they are similar. Fig. 3 shows a CorelDRAW Color 
Docker and a Color Palette used in Illustrator. 

IMPORT FILES VS. PLACE FILES 
Most projects require one to bring in artwork from another 
file. Corel uses the File > Import command while Adobe’s 
process is File > Place. Both accomplish the same thing. 

EXPORT VS. SAVE AS 
Often you will want a document to be output in a file type 
that differs from the native format. In Corel, you would 
choose File > Export and then the format you want. Adobe 
uses File > Save As followed by the format desired.

FOUNTAIN FILL VS. GRADIENT FILL 
Any object that has one color that fades to another is called 
a fountain fill by Corel and a gradient fill by Adobe. The 
techniques and names are different, but the results are 
the same. 

LOOKING TO CREATE RETRO TYPOGRAPHY IN 
ADOBE ILLUSTRATOR? VISIT http://gpro.link/retro

Fig. 3Fig. 3 Fig. 4

COLOR STYLES AND HARMONIES VS. LIVE COLOR 
Whenever you want to change an overall color scheme, both pro-
grams have features to facilitate it. Corel terms these color styles and 
color harmonies while Adobe uses the term live color. We’ll explore 
the CorelDRAW features in a future article.

COLOR PALETTE VS. SWATCHES PALETTE 
Both programs have an element to easily change the color of objects 
in a drawing. Corel calls them color palettes and Adobe calls them
swatches palettes.

OUTLINE VS. STROKE 
Whenever you have a shape or object, you can fill it with a color 
and also have a color follow its edge. Corel refers to that color as 
an outline and Adobe calls it a stroke. In addition to color, other 
properties can also be customized. 

CONVERT OUTLINE TO OBJECT VS. CONVERT STROKE TO 
OUTLINES 
This is the process that will separate the edge color from the fill color 
and make it into an individual vector object. 
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GUIDELINES VS. GUIDES
Both programs have a type of line that 
can be used for aligning objects. Corel 
calls them guidelines while Adobe has 
named them guides.

DYNAMIC GUIDES VS. SMART 
GUIDES 
Each program can make alignment 
lines visible when they are needed. In 
CorelDRAW, they are dynamic guides 
and Adobe terms them smart guides. 

WIREFRAME VIEW VS. OUTLINE 
VIEW 
Typically, while designing, you view 
a full color representation of your de-
sign but there are times when you want to see only the outline 
of each element or object in your drawing. Both programs have 
a view mode to do this. In Corel, select View > Wireframe. In 
Illustrator you would choose View > Outline.

POWERCLIP VS. CLIPPING MASK 
There are times when you will want one or more objects to have 
their visible shape defined by another object, kind of like pasting 
those objects inside another. Corel calls this PowerClip and is 
begun by choosing Effects > PowerClip > Place Inside Container. 
Adobe refers to this as a Clipping Mask and is achieved by selecting 
Object > Clipping > Make.

CONVERT TO BITMAP VS. RASTERIZE 
There are times when you’ll want to make selected objects in your 
drawing into a bitmap. While most elements in a drawing are vec-
tor based, sometimes it is best to make them into a raster-based 
bitmap. In CorelDRAW go to Bitmaps > Convert to Bitmap. 
Adobe has the same process by choosing Object > Rasterize. 

MACROS/SCRIPTS VS. ACTIONS
Both programs can automate certain tasks. Corel calls them macros 
or scripts. Illustrator calls them actions. 

POWER TRACE VS. LIVE TRACE 
Both programs have an automated feature to trace a raster image 
into a vector image, each with different options.

EXPORT FOR WEB VS. SAVE FOR WEB 
Both programs have a specific command to create the file needed 
when your design is destined for the web. In Corel, choose File 
> Export for Web and Adobe users would choose File > Save for 
Web and Devices. 

VIEW > PIXELS VS. PIXEL PREVIEW
Each program allows one to see exactly how a pixelated image will 
appear on the web by choosing View > Pixels in CorelDRAW and 
View > Pixel Preview in Illustrator.

COMBINE VS. COMPOUND 
Sometimes there will be two or more objects that you’ll want to 
merge into a single object. In Corel, it is called combine and Adobe 
calls it compound. Fig. 4 has a comparison of two individual 
objects at the top and the two combined at the bottom. 

BREAK APART VS. UNCOMPOUND 
The bottom object is comprised of three sub paths. The Break 
Apart command in CorelDRAW separates them into three indi-
vidual objects as does the Uncompound command in Illustrator.

CorelDRAW and Adobe Illustrator are both very capable design 
programs that have nearly equal abilities, but the terminology is 
quite different between the two. My hope is that I have been able 
to clarify the differences for users. Though I invite questions, 
since I no longer have a working copy of Adobe Illustrator, I will 
only be able answer questions regarding CorelDRAW. There are, 
however, many good books and tutorials available that are specific 
to Illustrator. Some of the concepts I’ve touched on here will be 
addressed in detail in future articles.

Questions, comments and/or insights should be directed to 
dezender1@gmail.com. GP

DOUG ZENDER has used CorelDRAW extensively since version 4. His goal is to 

minimize the intimidation of the program and give users the sense that CorelDRAW is a 

friend, not an adversary. Doug began as a design artist, then moved into the sign industry 

in 1992 doing vinyl graphics. You can contact him at dezender1@gmail.com.
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K
ids have never been happier to be 
back to school. After a long year-
and-a-half shutdown for most, 
school is back in session. And 

so far, back to school in 2021 and 2022 
looks a lot better than 2020. Schools wel-
comed kids back, sports are being played, 
fans are in the stands. But one thing is for 
certain, whether students are back to in-
person classes or a hybrid situation, they 
still want school spirit gear. Even dur-
ing the pandemic, students and parents 
found comfort in wearing school apparel, 
which helped to keep everyone bonded 
and together. Never underestimate the 
power of a printed school T-shirt.

SELLING TO SCHOOLS
As an apparel decorator with a heat press 
and custom transfers, you can offer schools 
everything they need for back-to-school, 
printed T-shirts, caps, sweatshirts, and 
more. Custom transfers give you the look 
of screen printing for a fraction of the ef-
fort. All you do is order them and heat 
apply.

It’s not always easy finding the right 
contact when working with schools. You 
may want to start by talking to parents in 
the neighborhood. Find out the contact 
for the parent-teacher group. Schools are 
always looking for successful fundraisers, 
and spiritwear can make money for both 
you and the organization. Don’t forget the 

middle and elementary schools. 
High schools usually have a book-
store where spiritwear is sold but the el-
ementary and middle schools get ignored. 
Try to find a contact for groups who may 
need custom apparel. Groups like student 
council, choir, band, yearbook, drama, 
sports teams, and booster clubs each usu-
ally have their own contact.

2022 SPIRITWEAR TRENDS
RETRO: Retro is a recurring theme. The 
question is, what is considered retro these 
days? You have to look back to the ’70s, 
’80s, and ’90s. In addition to garments 
with color blocking and stripes, you will 
find distressed prints and ’70s fonts are 
very hot.

TONAL TIE-DYE: Tie-dye has also been 
a reliable trend for many years, but this 
year we’re seeing it with a twist. Instead of 
a rainbow and multiple bright psychedelic 
colors, things are toned down a bit. It’s 
called tonal tie-dye. You’ll see orange on 
orange shirts or gray on black. A tie-dye 
pattern without all the color. It’s really a 
fresh way to use tie-dye and it’s perfect for 
spiritwear.

TEXTURE ON FLEECE: Everyone wants 
a sweatshirt when the temps drop. Hood-
ies, half-zips, and sweatpants are all part 
of back-to-school and teamwear across 
the country. This year, people are looking 
for texture and specialty finishes on their 

fleece. Puff transfers are back in 
style again and you can also use tex-

tured heat transfer vinyl on fleece. Flock 
and soft foam heat transfer vinyl are very 
popular on everything, from sweatshirts to 
stadium blankets. Another trend on sweat-
shirts is logo placement down the sleeve.

PRINTING ON BAGS AND OTHER ITEMS
If your local schools already have print-
ers providing them with spiritwear, try 
approaching them with a variety of other 
items. This could be anything from tote 
bags to stadium seats or even caps. Not 
every printer in town can print promo 
items. If you can offer promo-type items, 
you may eventually be asked to handle all 
their printing.

Remember, sometimes purchasing rela-
tionships with schools can take a while to 
create. Don’t give up. Even if you don’t 
have any contracts now, you can look 
ahead to spring, graduation, and fall events 
and sports. GP

KARIN BELLINGHAUSEN runs marketing and com-

munications at STAHLS’, a manufacturer of garment 

decoration equipment and materials. Karin has been 

with STAHLS’ since 1988. She manages web content 

and helps customers understand how to use group 

GroupeSTAHL products and services to grow their 

businesses.

    Team Sports

 Look Out for These 
School Spiritwear Trends 

in 2022
                         B Y  K A R I N  B E L L I N G H A U S E N

middle and elementary schools. 
High schools usually have a book-

fleece. Puff transfers are back in 
style again and you can also use tex
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PRODUCT SPOTLIGHT: TEAM SPORTS
For more on the suppliers featured in this section, please see website and phone information following each product. 

LASER ENGRAVER
GCC America Inc. offers the GCC LaserPro, recommended for 

customizing medals, trophies, plaques, and awards. Engraving 

tables range from 20.4" X 14.7" to 41.4" X 11" and have a maximum 

speed of 140" per second. The full line of laser systems feature a 

material database for different jobs and materials. 

909-718-0248
gccworld.com

BASKETBALL AWARDS
JDS Industries Inc. offers its basketball awards. The company 

says it has various options from medals and ribbons to resins or 

more traditional trophies and plawues. � Í�� order wualifies \or 

free shipping.

800-843-8853
jdsindustries.com

DESIGN SOFTWARE
GraphicsFlow offers its Graphics Builder 20 software, a new col-

lection of layouts, designs, graphic elements, textures, and fonts. 

It has 72 pieces of art and graphic elements, including geometric 

shapes, badges, ribbons, swooshes, pennants, and wavy lines. It 

also includes four texture backgrounds, 40 typefaces, and a library 

of layouts.

800-959-7627
graphicsflow.com

PERFORMANCE T
Royal Apparel offers its Performance Poly Tee, featuring DRI 

technology. T-shirt details include a set-on rib collar, double-

needle sleeve and bottom hems, and a satin label. It’s available in 

black, gray, safety orange, and safety yellow. 

866-769-2517
royalapparel.net
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POLYMER DECAL
World Emblem offers its FlexStyle 

polymer decal. The product comes 

with a three-dimensional look and a 

pressure-sensitive backing. It can be 

applied to glass, wood, metal, and 

plastic, and it comes with a low-melt 

adhesive. Emblems range in size from 

0.5" X 0.5" to 5.75" X 5.75". The thick-

ness varies depending on the com-

plexity of the design starting at 2 mm.

800-766-0448
worldemblem.com

TEAM SPORTS PRODUCTS
Johnson Plastics Plus offers thousands of blanks ready to per-

sonalize with sublimation, toner heat transfer, engraving, UV-LED 

printing, and vinyl application. Items include water bottles, apparel, 

bags, awards and more. 

800-869-7800
jpplus.com

POLYESTER BOONIE
Sportsman Cap & Bag offers its Legacy Cool Fit Boonie, which 

is a ���í polyester, cool fit, per\ormance hat. It is unstructured 

with a 3" snap-up brim, moisture-wicking sweatband, an adjust-

able toggle chinstrap, and black matte grommets. It features UPF 

50+ protection.

913-541-0901
sportsmancaps.com

DYNAMIC DUO
For creating unique, high profit hats

G
P0

22
2Hotronix® 360 IQ® Hat Press ⊲ stahls.com/htx-hat-iq

Dimensional Emblems & Patches ⊲ stahls.com/custom-dimension

STAHLS.COM | 800.478.2457          
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LOW-CURE INK
Lawson Screen & Digital Products introduces its Dynamic 

plastisol low-cure ink. The low-bleed ink is for printing on garment 

types such as cotton, polyester, 50/50s, and tri-blends. Dynamic 

ink is a so\t·hand, \ast·�ashing, low·cure ±��� �² opawue ink. It is 

available as a mixing system and to match any Pantone color.

314-382-9300
golawson.com

HEAT PRESS
Insta Graphic Systems o\\ers its Insta ��� 6wing �way heat 

press machine, their largest manual machine with ��Ç A ��Ç plat-

ens \or ease o\ use with larger substrates and trans\ers. It can also 

be used as a sublimation heat press machine.

562-404-3000
instagraph.com

PRODUCT SPOTLIGHT: TEAM SPORTS
For more on the suppliers featured in this section, please see website and phone information following each product. 

CUSTOM SPORTS MEDALS
Catania Medallic Specialty Inc. offers its custom sports medals. 

They are laser engravable and can be enhanced with color fill, cut·

outs, ribbons, keychains, and more. The company says custom 

medals can be manu\actured in three to five business days.

800-633-2586
cataniainc.com

PERFORMANCE HEADWEAR
Atlantis Headwear o\\ers its 6�(� sustainable per\ormance 

cap. It \eatures a six·panel, mid·profile construction with a slightly 

curved mid-visor and stretchable sweatband. The cap is made of 

��¯� certified recycled polyester¯elastane and is available in black, 

dark gray, navy, royal, and white.

atlantisheadwear.us
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RESIN SPORT AWARDS
Marco Awards Group introduces another family of 6" resin sports 

figures that includes baseball, basketball, soccer, and so\tball. 

These resin awards include a \ully sculpted design with \ull color 

sport balls. 

800-229-6592
marcoawardsgroup.com

PERFORMANCE CAP
Kati Sportcap & Bag o\\ers its Imperial �lter �go per\ormance 

cap. It is made \rom ���í polyester and is an unstructured, six·

panel, low·profile build with a pre·curved visor, gray undervisor, 

and per\ormance sweatband. The cap also \eatures ��Õ :2� 

ultraviolet protection.

800-392-5559
katisportcap.com

LEATHER WALL ADHESIVE 
General Formulations ����T5 @all'ark %eather incorporates a 

high·tack removable adhesive, while also o\\ering clean removal. 

The subtle textures can bring depth to wall murals, graphics, and 

decals, says the company. 

800-253-3664
generalformulations.com

ENGRAVING & CUTTING MACHINE
TrotecÂs 6peedy laser engraving and cutting machines work \or 

team sports applications, \rom trophies and awards to apparel. 

5uby laser so\tware streamlines processing by allowing users to 

create and edit designs without the use o\ a third·party so\tware, 

according to the company. 

866-226-8505
troteclaser.com

GP
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I
t’s easier than ever for small shops to 
get into apparel decorating. Not only 
has the technology improved greatly 
over the years, but mom and pops can 

get into the business for as little as $5,000.
The first step to starting an apparel deco-

rating business is to determine what type 
of apparel decorating you want to do. Is 

it T-shirts and ball caps or do 
you want to design your own 
clothing line for a pop-up shop 
in a mall? Sign shops are in a perfect 
position to branch out into apparel be-
cause they are already familiar with graphic 
design programs and printing equipment 
so the learning curve won’t be as steep and 

they already have a customer 
base in which to cross-sell dif-

ferent printing applications.
Many new businesses start out 

small. They buy a small screen printer or 
direct-to-garment machine and install it 
in their garage. As their business grows, so 
does the type of equipment they have on 

Popular Apparel 
Decorating Equipment
THE MACHINES YOU NEED TO GET AHEAD IN THE MARKET

      B Y  P A U L A  A V E N  G L A D Y C H
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Traditional screen printing is still just as popular as ever, particularly 

for print runs over 500 garments. (All images courtesy Xpresscreen)
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hand and the space necessary to meet the 
demands of their customers.

Traditional screen printing is still just as 
popular as ever, particularly for print runs 
over 500 garments, but direct-to-garment 
and direct-to-film printers are becoming 
more available and more affordable as 
companies scramble to tap into the growth 
in e-commerce that was fueled by the pan-
demic over the past two years.

More and more, individuals and busi-
nesses are doing their shopping online. In 
many cases, they want to purchase small 
runs of printed apparel and have them 
delivered quickly and efficiently with the 
click of a button. In this case, direct-to-gar-
ment or direct-to-film equipment makes 
the most sense because a shop doesn’t need 
a lot of space to run them, they are easy to 
learn, don’t require screens, solvents, and 
chemicals to produce a good product, and 
are perfect for any size order.

SCREEN PRINTING STILL KING
To get into screen printing, all someone 
needs is enough space for a small manual 
screen printing press and a small dryer to 
get started. They also would need an ex-
posure unit for making a screen and a flash 
curer to spot dry ink before you send it 
to the dryer, says Taylor Landesman, vice 
president of Lawson Screen & Digital 
Products. 

“You need to understand art and art pro-
grams and understand screen printing,” 
says Jay Doub, sales and technical service 
representative for Xpresscreen. “Both are 
learning curves.”

The beauty of choosing a program like 
CorelDRAW or Adobe Illustrator is that 
there are plenty of resources available to 
help get a new shop owner up to speed on 
how to use them, from community college 
courses to online instructional videos.

Shops also can save money by building 
their own darkroom and light table. He 
suggests that new shops buy at least a four 
platen, four hit press so that they can print 
white and three other colors. “Anything 
less is kind of a novelty,” he says. “I don’t 
see the point in it. They’re not expensive 
and it will make money for you.”
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If a shop is printing a white base on a 
dark shirt, a flash curer is imperative to 
dry that layer to the touch before adding 
colors on top. That could be as simple as 
pointing a hot air gun at the image to dry 
it by hand or purchasing a flash curer that 
can do the job in nine seconds.

Many shops don’t realize that they can 
screen print their own transfers. Where 
that comes in handy is when printing 
shirts for sports teams. Inevitably, a team 
will come back to the shop and ask for ad-
ditional shirts because they had some late 
signups. By screen printing heat transfers 
with the team logo during the first printing 
of shirts, the shop won’t have to go through 
the hassle of making new screens when ad-
ditional shirts are needed. They can just 
heat press the design onto the new shirts. 

Along with a heat press, screen printing 
shops should also invest in a spot removal 

gun for when they accidentally get an inky 
thumbprint on a sleeve and they don’t 
want to have to throw away the garment.

“If you have no clients, no customers, it 
is easier to start out with as little overhead 
as possible,” Doub says. But if the shop is 
already an established embroidery compa-
ny, for instance, that has been outsourcing 
its screen printing to a contract decorator 
for 10 years, it might make economic sense 
for them to buy their own screen printing 
equipment and start handling those jobs 
internally. 

Many people just getting into the in-
dustry get fooled by equipment vendors 
and distributors pushing how cheap it is 
to get into apparel decorating, but they 
don’t understand that there are other costs 
involved besides the cost of the press and 
heat press, says Nathan Belz, COO of Im-
press Designs outside of Dallas.

For screen printing, it takes inks, squee-
gees, screens, a good computer, monthly 
subscription to a RIP program and chemi-
cals for emulsion. Someone can get into it 
for $500 to $1,000, but “if they are trying 
to do any kind of good setup, a good home 
setup beyond being a hobbyist, $5,000 
would get you into something,” says Belz. 
That cost doesn’t include training and get-
ting up to speed.

If apparel decorating is going to be your 
actual job, most people would agree that 
it is important to start out with good 
quality equipment “otherwise you will be 
paying the price. Bad equipment doesn’t 
have resale value. It is trash when you are 
done with it,” he argues. If a shop spends 
a bit more money on name brand equip-
ment, even if the shop doesn’t last long, 
the equipment can still be sold so it isn’t 
money down the drain.
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Another benefit of buying good equip-
ment to start is that reputable shops typi-
cally offer training and troubleshooting if 
something goes wrong. 

Xpresscreen developed MiScreen, a di-
rect-to-screen thermal screen exposure unit 
which images directly from a computer to 
a special thermal screen, eliminating the 
need for chemicals, emulsions or water, 
keeping costs down and improving setup 
times. The only drawback of the technol-
ogy is that the screens aren’t as “rock solid” 
as conventional screens, so they are only 
good for 750 to 1,500 impressions. Most 
shops do jobs less than 500 shirts, so these 
screens are a more economical option, 
Doub says.

DIRECT-TO-GARMENT & HEAT-
APPLIED GRAPHICS
Many pop-up hobbyists have surfaced, 
peddling their own brands of apparel deco-
rating using some of the newer technolo-
gies, such as heat transfer vinyl, which has 
gotten significantly cheaper, or heat trans-
ferable film. Both technologies are similar 
to direct-to-garment, only the design is 
printed on film or vinyl and then pressed 
into the garment using heat.

“DTG has made great strides. There’s 
more flexibility but there is a learning 

curve to get involved in that,” says Belz. 
A small shop can get into heat transfer 

vinyl with a 24" printer and a heat press. 
To make things even more unique, they 
can add a single-head embroidery machine 
to the operation. If a shop wants to digi-
tize their own files, they will need a decent 
computer and a graphics program.

Belz says that many shops will focus on 
one type of printing, whether it is screen 
printing or DTG, but “will outsource to 
someone like us. We are a high-volume 
contract decorator doing eight million 
shirts per year.” They can handle the 
smaller apparel decorating orders and out-

source the larger jobs to companies with 
automated equipment that can complete 
jobs more quickly.

To print 500 shirts, it may take a shop a 
day or two if they are using a manual press. 
Belz explains, “We can do it in an hour. A 
lot of the time we can do that cheaper than 
they can. They sign us up as a contract 
decorator to do stuff outside their normal 
forte and they can still be full service and 
handle the part they are good at.”

He adds that if a shop outsources some 
of the larger screen printing or direct-to-
garment print jobs, it makes more room 
in their shop for heat-applied graphics, an 
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embroidery machine, or a cutter to cut vi-
nyl decals and stickers. 

“The apparel market is growing, espe-
cially the ability to do this at home and to 
sell online. It is really rising. Before, people 
would have shops and storefronts and sell 
shirts that way but e-commerce has been 
taking off and only really accelerated with 
COVID and everyone staying at home. 
There are more and more opportunities to 
sell online, to specialize,” says Landesman. 

A small shop can get into DTG for be-
tween $16,000 and $18,000, he says. That 
includes the printer, a pretreat sprayer 
and a heat press or conveyer dryer. Un-
like screen printing, which can print on 
just about anything, DTG printers work 
best with 100% cotton and certain cotton 
blends. 

Vinyl is another decoration option that 
doesn’t cost too much upfront. There are 
machines out there that print on vinyl and 
then cut it out, making it simple to apply 
to garments with a heat press. 

Most shops do both screen printing and 
DTG, using the DTG for smaller produc-
tion runs and screen printing for the really 
big runs.

“They each have their own niche and 
complement each other really well but, as 
DTG develops, certainly it is the wave of 
the future, we are not quite ready to re-
place screen printing yet,” he adds.

People wanting to produce their own 
clothing line will need a pad printer to 
put in neck labels or a way to sew in neck 
labels. Shops can also use heat transfers to 
put in neck labels. 

“I would say, after doing this for decades, 
the most common problem new people 
have is figuring out how to price or charge 
for what they’re doing,” Belz concludes. 
“Understanding what you are going to 
charge and how much time it will take and 
how much energy are all really important. 
It all revolves around knowing who your 
audience is.” GP

PAULA AVEN GLADYCH is a freelance writer based in 

Denver, Colorado. She can be reached at pgladych@

gmail.com.
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MASTER DECORATED APPAREL SALES
POSITION YOURSELF AND YOUR BUSINESS AS A BRANDING PARTNER

Sometime early on in my career as a 
commercial embroidery professional, 
I realized something that helped me 

become much more comfortable and suc-
cessful with making sales. I figured out that 
the people I was attempting to sell to were 
not buying clothes! 

Wait, what? We sell decorated apparel 
— how could I not be selling clothes? Let 
me explain.

All my customers, and yours, have clos-
ets filled with clothes. These people are not 
walking around naked. They own plenty 
of T-shirts, golf shirts, sweatshirts, and 
jackets. In fact, if you were to ask any one 
of them, they are likely to say they have 
too many of these things. Yet, here they 
are, asking you about buying something 
to wear. 

Once I wrapped my head around this 
concept, my sales process changed com-
pletely. It also accelerated to a completely 
different level because of the changes in 
the sales conversations I had with potential 
customers. I stopped selling clothing and 
started selling branded apparel and prod-
ucts. The key word here is BRANDED!

I realized that our customers had zero 
interest in becoming well-versed in ap-
parel. The apparel and products we offered 
were simply a delivery mechanism for their 
message, their brand. They had a problem, 
situation, or need they believed could be 
solved or resolved by making their brand 
visible.

ASK ATYPICAL QUESTIONS
In a traditional sales conversation, you 
do most of the talking. You explain what 
products you have, and what you can do 
to them for the customer. Hopefully, the 
customer picks one of the options you 
presented to them, and boom, you have 
made a sale.
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After I became aware that I was not 
selling apparel, my sales process changed. 
I asked the customer what the item was 
for, how it would be used, for whom it 
was being ordered. I asked questions so I 
could better understand what their need, 
problem, or situation was. 

At first, this felt very awkward and 
strange. The customers wanted to know 
why I was asking these atypical questions. 
I explained that I knew they had a closet 
full of clothes, so I suspected the order 
was not really about the clothes. Once I 

understood what their needs were, I could 
do a much better job recommending the 
best products to meet their needs within 
their price points. 

I would say, “For example, are you trying 
to identify your staff so your customers 
will know who to ask for assistance? Or 
do you want to have the kitchen staff look 
different than the serving staff?” At that 
point, the customer usually would jump 
right in and explain what they were look-
ing to accomplish with a branded apparel 
item or product. Most of the time, once 

we reached this point in the conversation, 
I knew that I would close a sale with this 
person. 

As a result of this conversation with my 
customers, I reframed how they thought 
of me and my business. I shifted from be-
ing an apparel decorator to becoming a 
marketing resource for them. The value of 
working with me and my company was no 
longer the same as working with another 
apparel decoration company. My custom-
ers felt that I “did more” for them now, 
without even knowing why in most cases.

MASTER DECORATED APPAREL SALES
POSITION YOURSELF AND YOUR BUSINESS AS A BRANDING PARTNER

Sometime early on in my career as a 
commercial embroidery professional, 
I realized something that helped me 

become much more comfortable and suc-
cessful with making sales. I figured out that 
the people I was attempting to sell to were 
not buying clothes! 

Wait, what? We sell decorated apparel 
— how could I not be selling clothes? Let 
me explain.

All my customers, and yours, have clos-
ets filled with clothes. These people are not 
walking around naked. They own plenty 
of T-shirts, golf shirts, sweatshirts, and 
jackets. In fact, if you were to ask any one 
of them, they are likely to say they have 
too many of these things. Yet, here they 
are, asking you about buying something 
to wear. 

Once I wrapped my head around this 
concept, my sales process changed com-
pletely. It also accelerated to a completely 
different level because of the changes in 
the sales conversations I had with potential 
customers. I stopped selling clothing and 
started selling branded apparel and prod-
ucts. The key word here is BRANDED!

I realized that our customers had zero 
interest in becoming well-versed in ap-
parel. The apparel and products we offered 
were simply a delivery mechanism for their 
message, their brand. They had a problem, 
situation, or need they believed could be 
solved or resolved by making their brand 
visible.

ASK ATYPICAL QUESTIONS
In a traditional sales conversation, you 
do most of the talking. You explain what 
products you have, and what you can do 
to them for the customer. Hopefully, the 
customer picks one of the options you 
presented to them, and boom, you have 
made a sale.
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OFFER EXTRAS
I amplified this perception at every op-
portunity. I offered to keep track of their 
orders by employee name, so they could 
reorder for an individual at any time with-
out having to dig up all the details. We 
created a spreadsheet for these accounts, 
and tracked the employees by name, size, 
and products ordered. 

We offered a “bag and tag” service, where 
each employee’s items were sealed in a clear 
bag, and then labeled. When the boxes ar-
rived, the customer could grab Joe Smith’s 
products easily, knowing he would get the 
correct items in the correct sizes. We did 
charge a small per item fee for this service. 
Once they used this service, they never dis-
continued it. The customers loved that we 
had made their life so much easier when 
it came to handing out products to their 
employees.

We offered a “try before you buy” service. 
I would bring in samples of the products 
in all sizes, XS-2X and leave them with 
the customer for a week. Their employees 
could try on the samples and then know 
exactly what to order. I would come back 

in a week and pick up the samples along 
with the order. We removed all the risk 
for the customer since they could order 
products in the exact quantities and sizes 
they needed. They did not have to order 
any extra inventory unless they wanted to 
have some on hand.

For our largest accounts, we took our cus-
tomer service one step farther. We provided 
order forms for their employees. The form 
listed all the products they could order, the 
sizes and colors available. Each employee 
completed a form and turned it in to the 
front office by a specified date. I stopped 
by and picked up all the individual order 
forms. The customer did not even have to 
compile the orders if they didn’t want to 
(some did). We did the work to compile all 
the orders and then sent the customer the 
summary of the order for their approval. 
You can also do all of this by offering an 
online company store to your customers, 
instead of paper forms. I was setting my 
company apart from my competition by 
providing a level of customer service to 
make the process of ordering custom ap-
parel as easy as possible. If you would like 

a sample of a custom order form, email me 
at Jennifer@nnep.com, subject: Order Form 
Sample, and I will send it to you.

It is easy to stay in the same sales pro-
cess and forget that it is not about the ap-
parel and products we offer. We are sell-
ing something completely different than 
T-shirts, sweatshirts, and jackets. We are 
selling branding, marketing, team build-
ing, customer service, and so much more. 
By positioning yourself and your business 
as a branding partner, you will outpace the 
competition, and they will not even know 
how. Adapt your sales conversations so that 
you are identifying and then meeting your 
customers’ needs, and the sky is the limit 
for you in 2022! GP

JENNIFER COX is one of the founders and serves 

as president of the National Network of Embroidery 

Professionals (NNEP), an organization that supports 

embroidery and apparel decoration professionals 

with programs and services designed to increase 

profitaOility and production¢ Bou can contact her at 

fenniferðnnep¢com¢
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APPLYING VINTAGE TECHNIQUES 
TO A NEW DESIGN

The modern Urban Dictionary defines 
vintage as an item of age, usually 
from at least 20 years ago or more. 

These items could be anything from fur-
niture and children’s toys, to clothing and 
household items. While the more tradi-
tional trusted Merriam-Websters version 
says vintage is similarly of, relating to, or 
produced in a particular vintage as it re-
lates to wine and of old, recognized, and 
enduring interest, importance, or quality: 
Classic! That just about sums it up. We 
like to say, as it relates to decorated appar-
el, “What’s old is new again.” Been say-
ing that for over 30 years now. In fact, we 
have written many articles about that very 
subject over the years. We can remember 
when Abercrombie & Fitch made vintage 
and distressed printing popular over three 

decades ago. Folks said it was a fad and 
wouldn’t last long. Yet here we are today 
still printing new versions of vintage tech-
niques. Vintage and distressed looks have 
trended for so long, we see it absolutely 
everywhere. It is very popular in photog-
raphy, for instance, where we can add a 
filter to a new photo for a vintage feel for 
that nostalgic look. We cherish that which 
came before and represents our history.

This was the familiar task we were 
asked to complete for a client. The di-
rection was a very distressed and washed 
out look to a reasonably complicated 
and detailed new design. This was for 
a western line known as Tin Haul. We 
have written about them in the past as 
well. Fortunately, in the spirit of the vin-
tage feel, we were printing on all light 

pastel-colored substrates and 
wouldn’t need a white printer 
or base plate to manage the 
colors. Typically, distressed 
images for screen printing 
don’t have too many fine de-
tails for obvious reasons. We 
risk losing detail once the tex-
tured layer is placed over the 

top. We constructed the image with some 
larger dark elements, like the silhouette 
we used for the bronc rider to reduce the 
loss of information and still be recogniz-
able. Our type was fairly bold as well, to 
not lose readability. We also used heavier 
line weights for the text, horseshoe, and 
star. The finer details were secondary 
elements. Adding dark centers to the 
sunflowers added back in some detail. 
We used multiple pastel colors to fill the 
space between the key lines, which pro-
vides much of the detail. 

The texture worked well on the larger 
elements but for the finer detail we used 
a fade with only a percentage of density 
removed and didn’t completely knock 
out areas of information. We used levels 
in the adjustment options under the Im-
age menu. That combination was used 
throughout. Because we wanted this im-
age super soft and subtle, we reduced the 
density of the entire thing, which helped 
keep the final print from filling in.

We tested several textures by print-
ing the design in color to size on pa-
per to physically see what filled in. We 
ultimately chose a burlap pattern with 

The direction was a very distressed and washed out look to a reasonably 

complicated and detailed new design. ±�ll images courtesy %on @inters² @e used levels in the adfustment options under the Image menu.
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lots of openings that weren’t too small. 
We increased the contrast of the photo 
of the burlap by overexposing the gray-
scale to help blow out the lighter values 
or anti-aliasing. When looking at just the 
color without the line definition, it was 
important that the colors had enough con-
trast. We knew our darker key line would 
fill in the gaps. We could still make out 
the breakdown of the colored elements 
easily enough and texture held up well. 
The hardcopy gave us the green light to 
proceed.

APPLYING VINTAGE TECHNIQUES 
TO A NEW DESIGN

top. We constructed the image with some 
larger dark elements, like the silhouette 
we used for the bronc rider to reduce the 
loss of information and still be recogniz-
able. Our type was fairly bold as well, to 
not lose readability. We also used heavier 
line weights for the text, horseshoe, and 
star. The finer details were secondary 
elements. Adding dark centers to the 
sunflowers added back in some detail. 
We used multiple pastel colors to fill the 
space between the key lines, which pro-
vides much of the detail. 

The texture worked well on the larger 
elements but for the finer detail we used 
a fade with only a percentage of density 
removed and didn’t completely knock 
out areas of information. We used levels 
in the adjustment options under the Im-
age menu. That combination was used 
throughout. Because we wanted this im-
age super soft and subtle, we reduced the 
density of the entire thing, which helped 
keep the final print from filling in.

We tested several textures by print-
ing the design in color to size on pa-
per to physically see what filled in. We 
ultimately chose a burlap pattern with 

Because we wanted this image super soft and subtle, we reduced the density of the 

entire thing, which helped keep the final print \rom filling in.

We tested several textures by printing the design in color to size on paper to physically 

see what filled in.

We increased the contrast of the photo of the burlap by overexposing the grayscale to 

help blow out the lighter values or anti·aliasing.
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Left: When looking at just the color without the 

line definition, it was important that the colors 

had enough contrast. Below: We knew our 

darker key line would fill in the gaps.

Since we were using multiple colors in 
this print, we took into consideration color 
theory, using contrast and compliments. 
Using a pastel violet against the pastel 
yellow helped keep the integrity of the 
design because of the natural contrast of 
complementary colors. In the background, 
a red is next to yellow, and both are warm 
colors, however the red values add natural 
contrast. 

For the overall design, the texture plays 
a major roll. The bolder darker elements 
kept this design from completely falling 
apart. It was a fine line. We knew we 
would lose some of the tiny details in the 
sunflower where the thinner lines for defi-
nition occur but that was to be expected. 
We were careful not to let that loss of de-
tail take away from the look of the overall 
print. This design was never really about 
detail, just representation. The subject 
matter was relevant to the client’s fashion 
line but ultimately this was about a nos-
talgic look.This was for a western line known as Tin Haul.
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Once our channel seps were completed 
in Photoshop, we placed the file on our 
Illustrator art board where our registra-
tion marks, grayscale and job information 
live. We outputted on CTS (computer-to-
screen) with a frequency of 55 LPI half-
tone at a 22.5-degree angle and a round 
shape. For a very thin ink deposit, all the 
screens were work hardened N-272 TPI 
(threads per inch) at a tension of 45 N/
cm. We nailed the setup with no micro 
adjustment right out of the gate. Truth 
be told, with how light the ink on the 
final print was, if we were close, it was 
hard to tell if we had any registration 
problems. All the inks were cut with a re-

ducer from 75% up to 99% for a nearly 
transparent look. We ran everything wet 
on wet using all 75/90/75 triple-ply, dual-
durometer squeegees with flood and print 
speeds wide open and minimal pressures. 
We had to play with some of the ink for-
mulations once we saw the first strike off 
but got most of the opacities right on the 
second try. Once approved, this thing ran 
at nearly 1,000 pieces an hour. The client 
absolutely loved the final image and has 
placed several reorders. Better to be lucky 
and good! GP

At 21 years old, LON WINTERS was the production 

manager for Ocean Pacific and started his 30+ year ca-

reer reclaiming screens. He’s the president and founder 

of Colorado-based Graphic Elephants, an international 

consulting firm and apparel decoration studio special-

izing in screen printing technical advances, plant design, 

layout, troubleshooting, productivity, quality analysis, 

and complete apparel decorating solutions. Learn more 

at www.graphicelephants.com.

In the background, a red is next to yellow, and both 

are warm colors, however the red values add natural 

contrast.

The client absolutely loved the final image and has placed several reorders.
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A P P A R E L  D E C O R A T I N G

Y
ou ever just take a step back in 
your line of work and notice that 
most companies are only focused 
on their price and how cheap they 

can market their products to the customer 
no matter if they are a new company just 
starting up or a multimillion-dollar com-
pany. The majority of companies are more 
worried about being the cheapest rather 
than known as one of the best and earning 

a healthy profit to grow their company.

$1 MORE
Most people when they start up in business 
have a lot to learn out the gate, but the first 
thing they try to do is match pricing or 
beat the pricing of companies larger than 
them, which is easier to do when you only 
have you as the employee. When we start-
ed our company, we did the complete op-

posite! We were one dollar more per piece 
on average than our competitors. We never 
focused directly on price. Why? Our com-
pany since day one has always been about 
having the topnotch customer service, 
helping to provide professional designs for 
free that we own, and hitting 99% of our 
deadlines on time or ahead of schedule. 

When you think about all of that, does 
that sound cheap to do? You have to be 
mindful when you are starting up or if you 

are a smaller company doing less than 
$1 million a year in sales. Your buy-

ing power is much less and your 
turnaround time could be slower 
when you have less people and 
you need to make sure you are 
paying yourself what you are 
worth or you will not enjoy what 

you are doing as much. You have 
one shot for your first impression 

when starting out. So, admitting you 
are not the cheapest, but you are focused 
on producing a higher end product for one 
dollar more is not that hard of a sell. You 
simply explain and educate your customers 
on what makes your services and products 
better than most or all others in your line 

$1 million a year in sales. Your buy

you are doing as much. You have 
one shot for your first impression 

 Making Moves with Pricing Sublimation

Don’t Focus 
on Being the 
Cheapest

B Y 
H O W A R D 

P O T T E R
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of work. Taking the time to explain your-
self shows your customer that you care and 
you want them to understand what they 
are getting for their investment no matter 
if it is a $20 or $2,000 sale.

Yes, you may not get every customer 
this way, but you will get the custom-
ers you can keep up with. You will get 
the customers that want the quality and 
customer service you offer. Your company 
will be earning the extra dollar per piece 
to invest into an employee or buying 
other supplies and equipment needed. 
Best of all, you will be doing work for 
a customer that not only wants quality 
but will promote you to their friends who 
typically have the same ideals. This makes 
it an easier sell since they heard about you 
from a friend. These types of clients are 
usually the easiest and most understand-
ing to work with.

STAY COMPETITIVE
When your company is hitting the next 
phase, like we did about eight to nine years 
in when we did our first million in sales 
for a year, you start looking at different 
things. You want to know how to improve 
your profit margin while maintaining your 
pricing, so now you are staying competi-
tive in the market. Notice I used the word 
competitive, and I did not use the words 
cheaper. So, when you hit this next level, 
your goal is to not only maintain sales, 
but grow them by 5%-10%. Our company 
grows no less than 15%-20% annually, so 
we know the plan works firsthand and has 
over our 18 years in business.

ERROR RATE
When your company is hitting at the next 
level in business, you want to focus on 
your error rate much more than ever be-

fore. The average in our line of work is not 
less than 5%. Imagine if you get it down 
to 2% annually. What does that do for 
your bottom line? Your staff is producing 
more orders correctly with very few errors, 
which means you can handle more work 
weekly and yearly netting a higher profit. 
You waste less supplies, utilities, and even 
better you customer is consistently happy, 
which naturally can put thousands more 
in profit back into your bottom line and 
allow you to afford to take care of your 
staff at the same time!

SELLING CHEAPER
When you are getting to the next stage 
of sales doing millions, you are now li-
able to keep feeding the beast called your 
company, so in many cases this is where 
most companies feel their only option 
to maintain and to grow their sales is by 
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becoming the cheapest at everything they 
sell. Can it work? Yes, but is it the only or 
best option? No!

If you are selling everything cheaper 
than everyone else you are not only hurt-
ing your bottom line, but you are hurting 
the market value as a whole, which only 
circles back to hurt you. I am not saying to 
never have cheaper pricing on something, 
but you never want it to be your main 
focus or the only way your company can 
grow. Come up with new products to sell 
that most do not have access to. A great ex-
ample during last year’s craziness: my wife 
and I have always wanted a laser engraver, 
so we had the time and did our research 
and purchased one this year. It was not 
only another compact piece of equipment 
we could run, but we can now produce 
volume with it and high profit margins, 
which allows us to maintain pricing with 
other processes on the backend by profit 
sharing to that department to stay aggres-
sive in the market. This is another product 
that is an easy sell to our existing custom-
ers. It is much easier to sell more to existing 

customers than it is to get new customers 
through the door.

When you are doing millions in sales and 
production it allows you to really use your 
buying power to help improve your profit 
margins. Certain supplies we used to buy 
weekly, but not many of them we buy once 
a month or once a quarter in bulk which 
not only gives us a better price per unit, 
but cuts down on shipping costs and time 
wasted ordering weekly, which really adds 
up to thousands more than you know.

As you can see, all these things really 
matter whether you are smaller or a larger 
company. Your main focus does not have 
to always be about being the cheapest. We 
all need to take a step back and look at 
the big picture. What do I want for my 
customers, staff, and my family and how 
do I achieve that? If you try to play the 
“I am the cheapest” game, it’s short lived 
because you clear very little profit margin 
from each order. If you make mistakes it 
chews up the profit margin from other 
orders and has you working for free. If 
you are a multimillion-dollar company, 

that game can really make it harder for 
you to take care of your staff since they 
are the backbone of the business. It also 
slows down you being able to invest back 
into your company fast enough to keep 
up with the growth! Remember, when you 
have the cheapest prices, you have more 
phone calls, orders, and typically more is-
sues at hand faster. This leaves you very 
little room for recovery. Being the cheap-
est is not always a long-term solution for 
success. Focus on your customer service, 
quality, and turnaround time and the rest 
will fall into place! GP

HOWARD POTTER has worked in the promotional 

industry for 17 years, from designing to building brands 

and a family-owned business. He is the co-owner and 

CEO of A&P Master Images LLC with his wife, Amanda. 

Their company offers graphic design, screen printing, 

embroidery, sublimation, vinyl graphics, and promo-

tional items. Howard, his family, and the business reside 

in Utica, New York. For more information, please visit 

masteryourimage.com.
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Welcome to the PRODUCT HIGHLIGHTS section where each 
month we offer you resources to enrich and expand your 
business with great services and products from our advertisers.

At Fruit of the Loom, we believe a more sustainable future is for 
everyone. Doing the right thing has been The Fruit Way for a long 
time now. From nurturing our people, to crafting our products, to 
caring for our planet, we fully understand the responsibilities we 

have as a global garment manufacturer and are committed to doing 
even more. Learn more about our actions and commitments at

fruitactivewear.com/sustainability.
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Fruitful
Futures

www.jdsindustries.com

Available in 8 Colors

WALLET
WITH STRAP

NEW

JDS_GP_sixthpg_0222.indd   1 12/30/21   7:39 AM

The Accu-Glide™ One-Man Squeegee Unit
is an inexpensive, high-quality solution for 
screen printing limited editions and short 
runs. And has been for over 45 years, 
passing the test of time. Pair it with a 
Rack-It™ Heavy-Duty Drying and Storage 
Rack for an affordable upgrade to your 
workshop or studio.

773.777.7100 | sales@awtworldtrade.com
www.awt-gpi.com

AN IMPECCABLE
IMPRESSION

Accu-Glide 
includes the Big 
Gripper2 and 
Sidekick Frame 
holder; frame is 
optional.
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866.402.7450
RicohDTG.com/GraphicsPro

Call for a FREE Deluxe 
Sample Pack!

#1 Best-Selling DTG Brand

RICOH Ri2000
Print a light shirt in only 25 seconds, 
a dark shirt as fast as 60 seconds!
Automated head cleaning 
and height adjustment
Low monthly payments +
0% APR for qualified buyers

• 

• 

• 

Trotec Laser USA
Trotec Laser USA

ruby.troteclaser.com

The most intelligent laser so�ware 
on the world’s fastest laser engraver

Speedy 400 
Run on Ruby

HOTMARKPRINT 
REVOLUTION

HOTMARK 
SIR 

HOTMARK
REVOLUTION

WWW.CHEMICA-US.COM

Printable & Cuttable Heat Transfer 
Films for Custom Apparel

TRANSFER YOUR IMAGINATION

SCAN ME
to connect with your local 
Chemica Distributor

The perfect
large 
format 
laser.

Removable Base for 
Large Object Engraving! 

The perfectThe perfect

APLAZER.COM   |   800-585-8617
 1709 THOMPSON ST. LANSING, MI 48906

Visit APLazer.com 
or call 800-585-8617

To explore how an AP Lazer 
can increase your profits.
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STAHLS' TAG ALONG™

HP PLATEN
Apply tagless transfers and full 
T-shirt fronts at once with this 
double-duty platen.

Tag Along™ is a patented design of the Livingston System

GP0222

GET YOURS TODAY
stahls.com/hp-double

DOUBLE
THE PRINTING
CAPABILITIES

Fast Change 
Frames

Sell More Graphics!
• Signage changes are 

FAST & EASY - sell 
more graphics and 
signs

• ANY size frame, 
LOW prices

• Made in Chicago for 
QUICK turnaround

• NO MINIMUMS:  
1 or 10,000

• Many color and 
profile choices

• FREE shipping on 
orders over $75 
to US States.

Manufacturing

NEW LED 
edge lit frames
Any Size, Any Color

1 Minimum
American Owned

American Made

5-2-20-EPILOG_gp_6th.pdf   1   5/4/20   2:48 PM

www.caseyspm.com
800-544-5620

Caseys’ TranslucencyTM

is a vellum-like material 
designed especially for you – the screen 
printer –to make inexpensive positives 
direct from your laser printer or copier.

Why so ugly?
Our Translucency appears yellow, because 
we’ve taken out the brightners that create 
the white color and also block ultra violet 
light from burning the screen.

It’s uglier, but it’s better.

Trial

$5
Pack

Since 1986

Kern's Optiflex
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THE MARKETPLACE

SIGNAGE & PRINTING

RESERVE YOUR 
SPOT TODAY!
graphics-pro.com/

advertise

SIGNAGE & PRINTING

Manufacturing

American Owned

American Made
Chicago, IL

sales@fastchangeframes.com
1-800-915-2828 

NEW LED 
edge lit 
frames

Any Size
Any Color

1 Minimum

American Owned

American Made1-800-915-2828 

Acrylic Stando� Frames, 
any size, any shape

• Easy installation &  fast graphic changes
• Dimmer & �ashing module for 

brightness control
• Super bright, even white light
• Thin pro�le, .96˝ thick
• 50,000 hours & 2 yr. warranty
• 25 various colors and frame choices
• Made in Chicago, IL USA For FAST 

Delivery nationwide

Manufacturing

American Owned

American Made
Chicago, IL

sales@fastchangeframes.com
1-800-915-2828 

NEW LED 
edge lit 
frames

Any Size
Any Color

1 Minimum

Acrylic 
Standoff 
Frames, 
any size, 

any shape

• Easy installation &  fast graphic changes
• Dimmer & �ashing module for brightness 

control
• Super bright, even white light
• Thin pro�le, .96˝ thick
• 50,000 hours & 2 yr. warranty
• 25 various colors and frame choices
• FAST Delivery 

nationwide
Cubicle Sneeze 
Guard Dividers

•  Made to any 
length or height

•  1/4” super clear, 
almost invisible 
Acrylic

•  Easy, do it yourself install, no tools required
•  Protects employees in adjacent cubicles 

when standing up

Desk Sneeze Shield
Protect your students and employees with 
Alpina’s Desktop Shields. Designed for 
standard 18” x 24” desks,  allows students
to bring their shields to and from class. 

-Trade Only-

Large Format
Dye-Sublimation

Custom Event Tent

Size: 10’ x 10’

$1.80 ft²

$448

B2sign.com
1 - 8 8 8 - 7 3 9 - 8 5 0 1

WIDE MEDIA
& Vinyl Handling Tools

The manufacturer of squeegees and applicators for over 30 years

Contact your local sign 
& equipment supplier

lidcoproducts.com

• Helps avoid
accidental
flopping and
folding media edges

• Helps maintain even tension
to reduce creasing

• Helps control large media pieces
• Helps avoid need for extra hands

30" and 54"
widths

LidcoAds_Final_newType.indd   4 10/29/12   10:26 PM

Automate XY Trimming with
KALA XY CUTTERS

•Eliminate labor when  
 trimming printed images
•Perfect for all    
 non-woven media 
•Save time, increase  
 efficiency and profits

Automate XY Trimming with
KALA XY CUTTERS

sales@supply55.com | 734-668-0755

AWARDS & ENGRAVING

PINT
GLASS

COOLER
$0.90

CAN
COOLER

$1.25W/ OPENER 
$1.80

BOTTLE
SUIT $1.50

CUSTOM PRINTING/asi 72242
www.MoreSales.com 1.800.226.3903

POCKET
COOLIE

$0.55

NEOPRENE/WETSUIT MATERIAL
BLANK SCREENPRINTER PRICING • 17 COLORS AVAILABLE

100'S OF THOUSANDS IN STOCK in St. Petersburg, FL

GPFEBMarketplace.indd   92 1/17/22   10:21 AM
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SIGNAGE & PRINTING

To advertise, visit:
graphics-pro.com/advertise

Got big news? 

Have a new 
product? 

Don't know 
where to start?

We can help!

Visit:
graphics-pro.com/

advertise

SIGNAGE & PRINTING

APPAREL DECORATING

• Teflon & Nylon Squeegees
provide stiff, smooth
applications

• Round & square corner variations
• 4" industry standard length
• Large format 6" & 12" lengths

The manufacturer of squeegees and applicators for over 30 years

Contact your local sign 
& equipment supplier

lidcoproducts.com

NYLON

TEFLON

NYLON

The World’s Leading 

SQUEEGEE
& Application Tools

AWARDS & ENGRAVING

Make Them In-House
systems starting at $799.00

www.rubber-stamp.com

Jackson Marking Products
800-782-6722

STAMPS

Sell More Stamps!

Create a
high-quality
pre-inked
stamp in
just three
minutes!

Instant Rebate
250$

Rebate offer expires June 30, 2013
Jackson Marking Products
800-782-6722
www.RubberStampMaterials.com
info@rubber-stamp.com

Jackson Marking Products
800-782-6722
www.RubberStampMaterials.com
info@rubber-stamp.com

Make Them In-House
STAMPS

Jackson Marking Products
800-782-6722
www.RubberStampMaterials.com
info@rubber-stamp.com

SIMPLE TO MAKE AND
HIGHLY PROFITABLE TOO!

Systems starting at $899

with Stamp Inventory
and FREE shipping

999$

Custom Stamps
• Highly Profitable
• Fast, Simple Production
• System on sale thru Feb. 28

50% OFF YOUR FIRST ORDER.
•13”x13.5”Std. Print Area
•Competitive Prices
•10 Pieces Min. Available
•Simulated Process
•Creative Art Staff

•Ganging
•Up to 8 Colors
•Rush Programs
•Hot or Cold Peel
•Opaque Inks

1st Street Graphics
Custom Heat Transfers for 46 Years

for pricing visit: 1ststreet.com/resellers
Username: resellers Password: 1ststreet
800-530-5909 or sales@1ststreet.com

PINT
GLASS

COOLER
$0.90

CAN
COOLER

$1.25 COOLERW/ OPENER 
$1.80

BOTTLE
SUIT $1.50

CUSTOM PRINTING/asi 72242
www.MoreSales.com 1.800.226.3903

POCKET
COOLIE

$0.55

NEOPRENE/WETSUIT MATERIAL
BLANK SCREENPRINTER PRICING • 17 COLORS AVAILABLE

100'S OF THOUSANDS IN STOCK in St. Petersburg, FL

go lawson .com  314 . 3 82 .93 0 0

Screen P r in t i ng D i rec t- to-Ga rment Heat T rans fe r

FREE SHIPPING on Supply Orders Over $99

APPAREL DECORATING

GPFEBMarketplace.indd   93 1/17/22   10:22 AM
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leys gear the pump down to 600 or 900 
RPMs. This means that there is less wear 
and tear on the pump, which will result 
in lower maintenance cost. Direct-drive 
units are louder than belt-driven ones, 
but the latter may need to have the belt 
tightened or replaced at some point in 
time.

Direct drive means that the motor is 
directly connected to the pump as op-
posed to a belt drive, where the motor is 
connected to the pump by a belt. With a 
direct-drive unit, the pump turns at the 
same speed as the motor, usually around 
1,700 RPMs or faster. With a belt drive, 
the motor turns at 1,700 RPMs, but pul-

THE TANK
The size of the tank of any given compres-
sor really does not matter much because 
our work requires a huge consumption 
of air. Much will depend on which tech-
niques you will use most often, as carving 
requires the most air. We will come back 
to the topic of air consumption a little later 
as well. The facts you need to consider are 
what volume of air your blaster consumes 
at the maximum pressure you will be us-
ing, and what is the air volume output of 
the various compressors at that pressure. 
If the tank is a 60- or 80-gallon tank, it 
doesn’t much matter, because at a pressure 
of 40 pounds in carving, you will deplete 
the air of either tank in four to eight min-
utes. GP

With over 35 years in the glass business, RUTH 

DOBBINS offers experience in fused and cast glass, 

as well as in glass-etching techniques. Ruth holds 

a Master’s Degree in Printmaking and Art History 

and has been a partner in a stained and fused glass 

wholesale supply company in Europe, which also 

placed great emphasis on a training program. You 

can reach Ruth by email at ruth@etchmaster.com, by 

phone at 505-473-9203. © Ruth L Dobbins

AIR COMPRESSORS

continued from page 57

Left: This diagram shows a common single-piston and pump found on 

electric air compressors. Right: Here is a cut out of a rotary screw compres-

sor to expose the twin screws that compress the air.
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1st Street Graphics Inc 93 www.1ststreet.com

6Sign 92 www.6sign.com

Alpina Mfg LLC 92, 92, 92 www.fastchangeframes.com

B2Sign Inc 92 www.b2sign.com

Comfort Colors IFC www.comfortcolors.com

Delta Apparel 73 www.deltaapparel.com

Digital Graphix Factory 93 www.digitalgraphixfactory.com

Epilog Laser BC www.epiloglaser.com

GRAPHICS PRO EXPO RA graphics-pro-expo.com

Graphtec America Inc 13 www.graphtecamerica.com
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Hirsch Solutions Inc 5 www.hsi.us

Jackson Marking Products 93 www.rubberstampmaterials.com
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JERZEES 6-7 www.jerzees.com
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Marco Awards Group 91 www.marcoawardsgroup.com

Mimaki USA 90 www.mimakiusa.com

Ricoh DTG 90 www.ricohdtg.com

STAHLS' 91 www.stahls.com

Trotec Laser GMBH 90 www.troteclaser.com
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DECORATORS 
COMMUNITY 
ANNOUNCES 2021 
AWARD WINNERS
VISIT http://gpro.link/decoratorawards 

5 SUBLIMATION TIPS 
FOR 2022
VISIT http://gpro.link/sub2022 

JDS EMPLOYEE WINS 
“EMERGING PROFESSIONAL 
OF THE YEAR” AWARD
VISIT http://gpro.link/jds

APPLICATIONS BIG AND 
SMALL: UV PRINTING 
FOR VARIOUS FORMATS
VISIT http://gpro.link/uvapps 

(Image courtesy Cutting Edge Lazer Engraving)

MICHIGAN AMPUTEE 
FINDS PURPOSE IN LASER 
ENGRAVING BUSINESS
VISIT http://gpro.link/purpose 

WHY STICKERS 
MAKE THE PERFECT 
ADD-ON PRODUCT
VISIT http://gpro.link/stickers

PANTONE ANNOUNCES 2022 
COLOR OF THE YEAR
VISIT http://gpro.link/pantone22 

Kate Mydland 

(Image courtesy 

JDS Industries)

(Image courtesy 

Rick Herbert, Ace 

High Printing)
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